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Acronyms 
CAD  Computer Aided Design 

CCITT  Comite Consultatif Internationale de Telegraphie et Telephonie 

DWG  AutoCAD Drawing File 

DXF  Data Exchange File 

EDO   ESA District Office 

EFS   Egypt Financial Services (Project) 

EPO   ESA Provincial Office 

ESA   Egyptian General Survey Authority 

ESRI  Environmental Research Systems Institute 

ETM  Egyptian Transverse Mercator 

GCP  Ground Control Point  

GDB  Geodatabase 

GIS  Geographic Information System 

GPS  Global Positioning System 

MXD  ArcMap Map Document 

MXT  ArcMap Map Template 

MRO  Model Registry Office 

NED95  New Egyptian Datum – 1995 

PDF  Portable Document Format 

REPD             Real Estate Publicity Department 

RDBMS Relational Database Management System 

RMS  Root Mean Square Error  

RO   Registry Office 

TIFF  Tag Image File Format 

TMS  Training Managers and Supervisors (Dutch-funded project)  

USAID  United States Agency for International Development 
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Section I: Course outline 
 
Introduction 
The Egypt Financial Services Project, funded by USAID, is undertaking an extensive four-
year technical assistance program to help develop a robust mortgage finance market in 
Egypt. Comprising four task areas, Task 2 ‘Registration’ is working with the Ministry of 
Justice and Egyptian Survey Authority to improve property registration in selected urban 
areas to ensure that this emerging mortgage finance market can successfully be 
established. The ESA Cadastral Operations training course has been designed to support 
the surveying methodology devised by ESA/EFS to conduct an ‘as built survey’ in Mokattam. 
There are three course modules Module A: Geodetic Control, Module B: Data Processing 
and GIS (this course) and Module C: Surveying.  
 
Training Location 
ESA Training Center, ESA Headquarters, Cairo 
 
Course format 
The course comprises lectures and exercises. In addition to course exercises there will be 
ample opportunity to undertake practical work. 
  
Course Duration 
The course will run for 2 weeks for 4 – 5 hours a day, followed by a 1 week class project that 
will take place the ESA compound prior to commencement of field operations. 
 
Trainees 
Trainees from ESA and the private sector will attend this course. It is assumed that trainees 
are conversant with ESRI’s ArcGIS software (this is a course pre-requisite). 
 
Administrative Matters 
The three course modules will run parallel. The Geodetic Control and Surveying modules will 
take place in the 2 classrooms at the ESA Training Center and the Data Processing and GIS 
module in the IT Lab at the ESA Training Center. Staff will be assigned to a single module 
for the duration of training according to their education, training and experience.  
 
Benefits 
Trainees will be able to competently and efficiently develop a cadastral index map for 
Mokattam. 
 
Trainers 
Trainers are all ESA staff members who have considerable experience in the development 
and delivery of training. All have participated in the Dutch TMS project. 



EFS Project Task 2 Registration 

2006-11-10_NEdmead_Module B_ESA Cadastral Operations Course_Front Page_ENG.doc 
Technical Report # 

6

Section II: An overview of the lectures 
 
There are 6 topics covered in this course. Course lectures and student notes appear in 
Annex A. The lectures and student notes have been designed so as to serve as reference 
material once the course has ended and field operations have begun. The topics are 
organised as follows: 
 
Introduction – covers an introduction to the GIS and Data processing methodology. 
 
ArcGIS refresher – provides a quick recap of ArcGIS functionality describing core 
applications ArcMap and ArcCatalog used for GIS and Data processing. 
  
Data collection – in which we look gathering existing data and converting it into usable 
format, including the indexing of mutation forms. 
 
Georeferencing data – in which we look how to transform local coordinates to coordinates 
of the ETM and make adjustments to the data so that it aligns correctly. 
 
Processing cadastral data – in which we look at the creation of parcels and buildings by 
means of heads up digitizing and data conversion. 
 
Preparing the Cadastral Index Map – in which we look at creating a cadastral index map 
using layouts adding standard cartographic elements such as north arrows and scale bars. 
 
Each section is followed by course exercises and practical work. 
 
 

 
 

Not sure of something? 
We are here to help you get the 
most out of this course. If 
something is not clear please 
feel free to ask. 
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Section III: An overview of the exercises 
 
Class exercises follow the lectures, see Annex B. There are a number of separate exercises 
which cover the data processing and GIS components of the methodology. The exercises 
have been designed to serve as a working manual for future reference once field operations 
have begun.  
 
Indexing – in which you learn how to record attributes from scanned mutation forms. 
 
Tracing – in which you will learn trace CAD polylines and create shapefile polygons 
(parcels). 
 
Heads up digitizing – in which you learn how to capture parcels from satellite imagery. 
 
Georeferencing – in which you learn how to georeference raster data. 
 
Spatial Adjustment, edgematching and rubbersheeting – in which you will learn how to 
convert CAD data to an editable spatial format, transform the data, adjust vertices by means 
of rubbersheeting and match data along map sheet edges. 
 
Hyperlinks and Associations– in which you learn how to link mutation forms to parcels 
using hyperlinks, joins and relates. 
 
Merging – in which you learn how to combine different layers of data together. 
 
Map production – in which you prepare a cadastral index map and apply standardized 
symbology. 
 
Notations used in exercise notes 
 

 Where a paragraph is indented with a square bullet as this one is then you are reading 
an instruction that should be followed. 

 
Where a paragraph is not indented like this, then you are reading background information, 
generally indicating what it is you are about to do or have done. These are not instructions 
and should only be read. 
 
 
 
 
  

 
 
 

NOTE: When you see a note like this then a tip or 
some advice is being given. 

 
A course evaluation form appears in Annex C and a glossary of terms in Annex D. 
 
 

Callouts 
Where you see call out boxes such 
as this one then additional 
information is being provided to you 
to help you in your task.
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ANNEX A: 
 

Module B - Lecture material and student notes
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Objectives

• To learn how to process cadastral data

• To learn how to georeference and adjust data

• To learn how to prepare a cadastral index map

Objectives
The objectives of this course are to introduce the methods and procedures required to 
process cadastral data including georeferencing and spatial adjustment, data capture and 
conversion and the preparation of the cadastral index map using GIS. The GIS software 
used for this course is ArcGIS. 
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Training Methods

• Presentations
• Exercises
• Class project

Training Methods
A variety of training methods will be used lectures (presentations), exercises and a class 
project. Your instructor will present a section, which will then be followed by a class 
exercise. A series of exercises using sample data are found at the back of this manual. 
These exercises are designed to convey the principles outlined in the lectures. You can 
revisit these exercises at anytime. During the course you have plenty of opportunity to use 
ArcGIS for data processing operations. The class notes are designed to serve as a manual 
for field work when you begin field operations. If you have any questions during the course 
please ask your instructor.
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Logistics

• 3 week course
• Daily schedule
• Facilities
• Feedback

Logistics
This is a 3 week course. 2 weeks of the course are classroom based, to be followed by a 1 
week class project which will take place in the ESA compound. 
The trainer will explain the logistics of the course, the daily schedule, the layout of the 
training facility and advise you of the location of toilets and fire exits. On completion of the 
course please complete a course evaluation form so that we can improve the course in 
future. You will find the course evaluation at the back of this manual, along with a glossary 
of terms which you can use for reference purposes.
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Section overview

• Course overview
• GIS refresher
• Data processing methodology

Section overview
This section outlines the topics covered, provides a recap of GIS principles and GIS 
functionality, a description of ArcGIS and an overview of the proposed GIS and data 
processing methodology.
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Course overview

• ArcGIS refresher
• Processing data
• Geoferencing and spatial adjustment
• Preparing a cadastral index map
• Class project

3 w
eeks

3 w
eeks

Course overview
This course covers the use of ArcGIS to process existing cadastral data and new acquired 
field data to generate a cadastral index map and cartographic product. During the course 
we will cover data collection and data processing, georeferencing and transformation of 
existing data and the preparation of the cadastral index map. 
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What is a GIS?

• “A computerized information system for the management 
of spatial data”

• An integration of five basic components:
– People
– Data
– Hardware
– Software
– Procedures

What is a GIS?
Definitions of a geographic information system can vary considerably. The definition provided 
here combines both the components and functions of a GIS. The components needed to 
perform GIS tasks include those listed below:
People: This is the most important component in a GIS. People must develop the procedures 
and define the tasks of the GIS. The best software and computers in the world cannot 
compensate for incompetence.
Data: The availability and accuracy of data can affect the results of any query or analysis.
Hardware: Hardware capabilities affect processing speed, ease of use and the type of output 
available.
Software: This includes not only the actual GIS software, but also various database, drawing, 
statistical, imaging or other software.
Procedures: Analysis requires well defined, consistent methods to produce correct and 
reproducible results.
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GIS functions

CaptureCapture

StoreStore

QueryQuery

AnalyzeAnalyze

DisplayDisplay

AnalyzeAnalyze

GIS functions
Any geographic information system should be capable of the following fundamental 
operations in order to be useful for finding solutions to real-world problems.
Capturing data: A GIS must provide methods for inputting geographic (coordinate) and 
tabular (attribute) data. The more input methods available, the more versatile the GIS.
Storing data: There are two basic data models for geographic data storage vector and raster. 
Querying data: A GIS must provide utilities for finding specific features based on their 
locations or attribute values.
Analyzing data: A GIS must have the ability to answer questions regarding the interaction of 
spatial relationships between multiple datasets.
Displaying data: There must be tools for visualizing the geographic features using a variety 
of symbology.
Output: Results of display should be able to be output in a variety of formats such as maps, 
reports, and graphs.
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Components of geographic data

• GIS data has two basic components

AttributesAttributes

GeometryGeometry

Components of geographic data
The two basic components of GIS data are Geometry and Attributes. Geometry is 
the physical representation of a real world object. Real world objects are abstracted 
into point, line or polygon (area) features. Attributes are descriptive information 
about a feature. In the geodatabase (a new spatial format for ArcGIS) another 
component of GIS data is behavior. For example domains can be used to enforce 
permissible attribute values ensuring something is not incorrectly described.
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Organizing spatial data

• A GIS works with layers of spatial data

Layers in 
ArcMap

Layers in 
ArcMap

Organizing spatial data
A GIS organizes and stores information about the world as a collection of 
thematic layers that can be linked by geography. Each layer contains 
features having similar attributes, like streets and cities, that are located 
within the same geographic extent. This simple but extremely powerful and 
versatile concept has proven invaluable for solving many real world problems 
from tracking delivery vehicles to modelling global atmospheric circulation.
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Abstracting real world objects

• Real world objects represented as three basic shapes

Lines
(Streets)

Points
(Geodetic control)

Polygons
(Parcels)

Real worldReal world

Abstracting real world objects
It is impossible to capture everything from reality inside a computer. Instead, 
GIS users must somehow abstract real world phenomena, or entities, into a 
geometric representation of those entities. There are three basic geometric 
shapes used for geographic features: points, lines, and areas. These shapes 
are often called geometric objects, geometric features, or feature types.
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Georeferencing data

• Locating your data in real world coordinates
• Different coordinates means misalignment

LocalLocal

ETMETM

NED 95NED 95

0,0
Different coordinate 

systems in Egypt
Different coordinate 

systems in Egypt

Georeferencing data
One important issue you must confront when adding data to your database is how to 
ensure that all of the features in the individual datasets are properly aligned to 
locations on the earth’s surface. In Egypt you may encounter local coordinates, 
coordinates in the Egyptian Mercator System (ETM) and even coordinates in the 
New Egyptian Datum 1995 (NED 95). The problem is that none of these layers, in 
the differing coordinate systems, will align correctly and transformations will need to 
be applied to correct this misalignment. Transformations are covered in more detail 
in Section 4: Georeferencing and Adjustment. It is important that you understand the 
coordinate system of data provided to you to ensure you apply the correct 
transformation, although in reality you may have little idea about a dataset’s 
coordinates and projection system unless it is described by metadata.
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Overview of ArcGIS desktop products

ArcGIS
applications

ArcGIS 
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ArcInfo

ArcEditor

ArcView

ArcCatalogArcCatalog ArcMapArcMap

Overview of applications
During this course you will make use of ArcGIS. ArcGIS is a desktop GIS from ESRI. 
There are 3 ArcGIS products: ArcView. ArcEditor and ArcInfo that increase in 
functionality and price. You will be using ArcView in this course. Each of the 3 
products share the common applications ArcMap and ArcCatalog. These are 
designed to work together to perform all GIS tasks. For example, you can search for 
and find a map document in ArcCatalog, then open it in ArcMap by double-clicking it 
in ArcCatalog. You can then edit and enhance your data through the tools available 
in the ArcMap editing environment.
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Data processing methodology

• Data processing strategies for cadastral data:

Existing data -
CAD format

New field survey data -
CAD formatMutation forms

GIS database

Convert and 
georeference
Convert and 
georeference

IndexIndex
ConvertConvert

Data processing methodology
The GIS and data processing methodology proposes that both existing and new CAD data 
be converted to the ESRI shapefile format and mutation forms indexed. When necessary 
existing data will be transformed to ensure its coordinate system is correct. All data 
processed will be held in a GIS database that is amenable to analysis, map production, 
modification and update.
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Processing existing data 

• Process existing data
– Index mutation forms
– Convert CAD data to shapefile format
– Attribute properties
– Link mutation form details

Mutation Forms

Database

Parcels and 
Buildings

Processing existing data
Where parcel and building information is already available in CAD format (e.g. from ESA for 
the Mokattam area) this will be converted to shapefile format using ArcGIS. Where mutation 
forms exist they will be indexed using MS Access. It will then be possible to link the 
mutation form and parcel/building/apartment together.
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Mutation form database

• Property Object and Initial Transaction table
• Subsequent Transactions table

Mutation form database tables 
linked by common field

Mutation form database tables 
linked by common field

Mutation form database
A mutation form database will be created to hold details from mutation forms – there are 
two required tables one for the property object and its initial transaction and one for 
subsequent transactions. Using a common field (e.g. mutation form number) these tables 
can be linked together as shown in the graphic above. This is described as a one to many 
relationship type, one property object – many transactions. 
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Index mutation forms

Property addressProperty address

Subsequent 
transactions
Subsequent 
transactions

Initial transactionInitial transaction

Index mutation forms
Mutation forms will be scanned and key details be indexed. Mutation forms comprise 4 
pages and they are slightly smaller than A3 size. The slide above shows some of key 
attributes that will be indexed. All pages of a mutation form (including the sketch) will be 
scanned using a flatbed scanner and saved as a TIFF image file.
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Convert CAD outlines to polygons

• Trace polylines to create polygons

AutoCAD Drawing 
file

AutoCAD Drawing 
file

Trace in ArcGISTrace in ArcGIS

Create polygonCreate polygon

Convert CAD outlines to polygons
Where CAD data exists for an area, typically the CAD data represents parcels and 
buildings as a series of connected lines. Whilst this is correct in the strict sense that parcel 
boundaries have dimensions (i.e. length and direction) the lines themselves do not 
constitute an area i.e. there is no way to click inside a parcel and determine its area or 
determine its identifier. Where CAD polylines exist they will be converted to polygons using 
different editing tools in ArcGIS, for example the Trace tool as shown above. Where CAD 
polygons exist (i.e. closed polylines) they will be converted directly to an ESRI spatial 
format.
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Linking mutation form details

• Common field mutation form number
– Links property details and transactions to a property

Common field allows 
parcel and mutation 

form details to be 
linked

Common field allows 
parcel and mutation 

form details to be 
linked

Linking mutation form details 
Once parcels have been created and mutation form details indexed they can be linked 
together using the common field mutation form number which is an attribute both of the 
property feature class and the property object and subsequent transactions table in the 
mutation forms database.
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Processing new data

• Field survey data
– Process field data using AutoCAD
– Convert CAD data to shapefile format
– Attribute properties

Database

Parcels and 
Buildings

Processing new data
New data will be acquired during the field surveying phase. Since this is new data, there 
will be no mutation form associated with the parcel/building and the feature will only be 
assigned a property identifier. New data will be referenced directly to the ETM coordinate 
system and will not need to be transformed. Once new data has been processed it will be 
combined with existing data to create a complete cadastral picture for an area of interest.



Introduction v0.2.ppt
Module B: ESA Cadastral Operations Course
Technical Report # 1-21

Field surveying

• Total Station and hand held laser distance tool
• Process results using AutoCAD

Surveying and 
laser sighting

Surveying and 
laser sighting

Field surveying
Survey crews will gather parcel outlines and building footprints using Total Station and 
Hand Laser distance tools. All data (as per current ESA practices) will be processed using 
AutoCAD. There are separate course modules covering Geodectic Control and Field 
Surveying.
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Convert CAD outlines to polygons

• Trace polylines to create polygons

AutoCAD Drawing 
file

AutoCAD Drawing 
file

Trace in ArcGISTrace in ArcGIS

Create polygonCreate polygon

Convert CAD outlines to polygons
As with existing CAD data polylines will be converted to polygons using different editing 
tools in ArcGIS, for example the Trace tool as shown above. If CAD polygons are
generated by the field survey teams this data will be converted directly to the ESRI 
shapefile format.
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Assigning a new identifier

• Assign a new id based on MSAD/ESA standards:

Identify private parcel
Number xxxyyyzzz

Map building footprint on parcel

Identify apartment unit
Number xxxyyyzzz0612

The principles of 
property numbering
The principles of 

property numbering

Assigning a new identifier
New properties will be assigned a unique parcel identifier using the coding system devised 
by MSAD/ESA (or another alternative numbering system, for example as devised the ESA 
Provincial Office). The principles of a property coding system is shown above, typically 
these systems include numeric identifiers for administrative areas as well as the property 
itself, they may even be alphanumeric. For example in the UK each property is identified by 
a Unique Property Reference Number (UPRN). Each UPRN is a maximum of twelve digits 
and is unique within the UK.
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ESA/MSAD real estate number

• Proposed number format:

ESA/MSAD real estate number
The ESA/MSAD real estate numbering (REN) system foresees Egypt broken down into 
map sheets of 1.5 by 1 km which in turn are broken down into 6 grids. The numbering 
system then is broken down by block, building, suite, storey, floor and apartment number. 
The identifier comprises a total of 19 digits, note that this a proposed numbering and is 
subject to change.
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Representing apartments

• One polygon for each apartment 
– Geometry indicative only

• One polygon for communal area
– Building footprint

• Each polygon assigned an identifier
– Links to mutation form

6723493434567234934345

6723493434667234934346

6723493434767234934347

6723493434867234934348

6723493434967234934349

6723493435067234934350

Representing apartments
Each apartment (and communal area) should be represented by one polygon, the geometry 
is only indicative i.e. that this an area of ownership, it is not meant to show the exact 
boundaries or dimensions of the apartment. For example if there were a 15 apartments 
there would be 16 polygons – one for the communal area which has its own mutation form 
and one polygon for each apartment. Each polygon is then assigned an identifier so that it 
can be linked to its mutation form. Field teams will collect information about apartments 
when surveying building footprints. They will complete a Building Report which includes 
number of apartments as well as those occupied and unoccupied.
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Create cadastral index map

• Final product is a cadastral index map 
– Digital and analogue

• Analogue product follows ESA cartographic standards

Hardcopy Cadastral 
Index map

Hardcopy Cadastral 
Index map

Create cadastral index map
The hardcopy output of the GIS and Data processing component will be the Cadastral 
Index map. ESA has standards regarding the content and symbology of these maps and 
these standards will be followed when printing or plotting large scale maps for the 
Mokattam area. The cadastral index map will be vetted by ESA to ensure it meets their 
quality control standards.
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Section 2:
ArcGIS refresher
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Section 2 overview

• What is ArcGIS?
• ArcMap
• ArcCatalog
• ArcToolBox

Section overview
This section provides a brief overview of ArcGIS, the applications that comprise it and how 
they are used. 
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Objective

To provide an overview of ArcGIS and how it can be 
used to process cadastral data

Objective
In order to be able to successfully undertake data processing operations using GIS, a brief 
overview of the GIS solution is provided. As mentioned this is not an ArcGIS per say but 
this section serves as a refresher for those already familiar with ArcGIS.
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What is ArcGIS?

• Desktop GIS 
– Provides tools for the management of spatial data

• Easy to use GUI based application
– Fully documented with on-line help

• Two core applications:
– ArcMap
– ArcCatalog

What is ArcGIS?
GIS is defined as a “computerized information system for the management of spatial 
(geographic) data”. Using GIS you can create, manage, analyze and present geographic 
information. ArcGIS is an easy to use GUI based application that provides all the tools 
needed to perform the data processing tasks described in the Cadastral Operations 
methodology. ArcGIS is fully documented with on-line help and web based resources. If 
you have any questions about ArcGIS during the course please feel free to ask your 
instructor.
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ArcMap

• Visualization application 
• For map-based tasks:

– Displaying
– Symbolizing
– Editing
– Querying 
– Analysing
– Charting
– Reporting
– Presenting

Table of 
contents
Table of 
contents

Display 
area

Display 
area

ArcMap
ArcMap is the primary display application, you will use this the majority of the time to add 
data, symbolize data (i.e. create thematic maps), edit data, query data (select features by 
attribute or location); create charts, reports and layouts (maps) for printing, plotting or 
export. layers. You can export layouts to TIFF, BMP and many graphic file formats to share 
maps with non-GIS users.
ArcMap comprises a table of contents, display area and toolbars. The table of contents 
(TOC) lists all the layers or themes of geography you are working whilst the display area 
shows features contained in the layers. Use ArcMap toolbars to navigate around the base 
map, add data, save your work and create layouts.
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Adding

• ArcGIS supports many spatial formats
– CAD, Shapefile, Raster

• Add data to a map document
• Layers reference data on disk

Layers and data 
frames

Layers and data 
frames

Shapefiles on diskShapefiles on disk

Adding
You can add many different spatial data formats to a map document – CAD data, shapefiles
and geodatabase feature classes. When you add data to a map document you create a 
layer – a layer references the source data on disk. Once a layer has been added it can be 
symbolized, queried and edited. Layers are organized by data frames or containers of 
spatial information. In the slide above Cairo Environs is a data frame, it is identified by the 
three yellow stacked layers. 
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• ArcGIS can work with spatial data in multiple formats

ArcGIS

Supported spatial data formats

Tables

Coverage

Shapefile

CAD

Geodatabase

Raster

Internet Map 
Server

Supported spatial data formats
Currently, there is not a standard format for GIS data.Various GIS software 
manufacturers and other organizations, such as government agencies, have 
continually searched for more efficient and versatile digital formats to store 
geographic information. ArcGIS has the advantage of seamlessly supporting all of 
the ESRI formats: shapefiles, coverages, grids, the geodatabase and data served 
over the internet by ArcIMS or ArcGIS Server. In addition ArcGIS also supports the 
three most common CAD file formats (DXF, DWG and DGN), as well as a variety of 
common image file (Mr. SID, BSQ, BIL, etc) and tabular formats (MS Access tables, 
DBF and text files). The ability to work with so many different formats without 
needing to convert them is a tremendous advantage.
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Navigating

• Tools for zooming in/out, panning viewing to scale

Scale notation drop-down 
menu sets map scale

Scale notation drop-down 
menu sets map scale

The Tools toolbar contains 
navigation tools

The Tools toolbar contains 
navigation tools

Navigating
Use the Tools toolbar to zoom in and out, zoom to previous/next, pan and zoom to the full 
extent of all layers in the data frame. You can also use the scale notation drop-down menu 
to zoom in and out. You can either you a predefined scale or enter a scale yourself e.g. 
1:500. You can use the navigation tools in the Layout view allowing you to create maps for 
printing and plotting of fixed scale as required by ESA.
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Symbolizing

• Property of the layer
• Select legend type

– Unique values
– Graduated colors
– Graduated Symbol
– Pie Chart
– Dot Density...

• Set legend properties

Creating a graduated 
colors legend

Creating a graduated 
colors legend

Symbolizing
You can create thematic maps (maps which are symbolized in such a way as to present 
information) using the Symbology tab in the Layer properties dialog box. First choose a 
legend category: Features, Categories, Quantities, Charts or Multiple Attributes then a 
legend type. Use Categories for descriptive values and Quantities for numeric values. For 
example under Categories choose Unique Values to give each feature with a unique 
descriptive value (e.g. district name) a unique symbol. Under Quantities choose Graduated 
Colors to assign a gradation of colors to numeric values with the deepest color representing 
the greatest numeric value.
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Labeling

• Add text to map
• Based on feature attributes
• Set label properties

Labeling districts by 
Arabic name

Labeling districts by 
Arabic name

Labeling
You can label (add text to) features by selecting an attribute and setting the properties for 
the label. In the example above district names are shown in Arabic. Labels are dynamic 
that is they are repositioned every time you zoom in and out. There are rules governing the 
placement of labels too, which makes for a clear uncluttered display. If you do not want text 
moving around the display – for example you want a fixed location for a street name you 
can create annotation. Annotation is described in more detail in Section 6: Preparing the 
Cadastral Index Map.
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Querying

• Select features 
– By their description
– By their location
– Interactively
– Using graphics

Select by AttributesSelect by Attributes

Select by LocationSelect by Location

Querying
You can select features in a number of different ways, by their description using a 
Structured Query Language (SQL) statement (e.g. Population > 50,0000), by their location 
(e.g. find all properties within 50 meters of a road), interactively by using the mouse/cursor 
or by using a graphic drawn in the display. 
Selected features are displayed in cyan. To determine how many feature have been 
selected either open the layer’s attribute table or click on the Selection tab at the bottom of
the map document’s table of contents:

Number of features selected 
appears under the Selection tab in 

the TOC

Number of features selected 
appears under the Selection tab in 

the TOC
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Editing

• Select editable layer
• Set edit task
• Use sketch tools

The Editor toolbarThe Editor toolbar

Editing
Editing is covered in some detail in this course, suffice to say that in ArcMap you use the 
Editor tool bar to start an edit session, specify the editable layer and set an edit task. To 
perform an edit task you use a sketch tool (the default sketch tool is the pencil). For 
example to draw a new parcel boundary choose to start editing, set the editable layer to 
parcels, the edit task to create new feature and use the sketch tool to draw a parcel outline 
in the display. When you have finished your edits you can save your work and stop editing.
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Presenting

• Create a layout
• Add cartographic elements

– Title
– Scale Bar
– North Arrow
– Legend
– Logo

Map production 
using layouts

Map production 
using layouts

Presenting
Using layouts you prepare cartographic products for printing, plotting or export (for example 
to PDF files). To switch to the Layout view choose Layout View from the View menu or click 
on the Layout View button at the bottom of the map document’s display area. To insert a 
cartographic element click the Insert menu and choose the type of element to add. All 
elements are dynamic, for example if you zoom out the scale bar will adjust itself. In 
addition the map in the layout view is ‘live’ i.e. using the Tools toolbar you can zoom in and 
out or pan the data frame to set the correct extent of the map you want to print.



ArcGIS refresher v0.2.ppt
Module B: ESA Cadastral Operations Course
Technical Report # 2-14

ArcCatalog

• Data management application
• For spatial data tasks:

– Creating
– Renaming
– Deleting
– Moving
– Searching
– Previewing

Catalog
tree

Catalog
tree

Contents 
view

Contents 
view

ArcCatalog
ArcCatalog is the data management application. Use ArcCatalog exclusively for the 
management of geographic information – do not use Windows Explorer. Using ArcCatalog 
you can create new spatial data, move, copy, rename and delete data, as well as search 
and preview data before its use.
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Creating

• Choose spatial format
• Set properties

– Name
– Geometry
– Spatial reference
– Attributes

Creating a new 
shapefile

Creating a new 
shapefile

Creating
Use ArcCatalog to create new data, be it spatial or tabular. When creating new spatial data 
you can create either shapefiles or personal geodatabase feature classes. Irrespective of 
which type of spatial data you choose to create you must name the new dataset, set its 
geometry type (point, line or polygon) and its spatial reference. You can also fields to  the 
dataset’s attribute table to store descriptive information. Once you have created a new 
feature class or shapefile in ArcCatalog you must edit it in ArcMap.
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Managing

• Copy
• Rename
• Move
• Delete

– No recycle bin!

Managing dataManaging data

Managing
Use ArcCatalog exclusively for the management of spatial data, you can copy, rename, 
delete and move data. In addition you can create and delete folders on disk. Remember 
there is no Recycle bin so deletions cannot be undo
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Exploring

• Search for data
• Examine data

– Geography, Attributes, Metadata

Examining a shapefileExamining a shapefile

Searching for dataSearching for data

Exploring
Using ArcCatalog you can search for geographic data by name and location, geography, 
date and metadata. Search results are returned as shortcuts which behave like data, you 
can drag and drop a shortcut into ArcMap without knowing where the source data is. You 
can also examine data before using it – under the Contents tab you can view the contents 
of folders and geodatabases, under the Preview tab you can examine the features and 
attributes of a feature class or shapefile and under the Metadata tab you can examine 
descriptive information about the data.
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ArcToolBox

• Data analysis and automation 
application

• For spatial analysis tasks:
– Clipping
– Merging
– Buffering

• Dockable window in 
ArcMap/ArcCatalog

Toolboxes, 
toolsets and tools

Toolboxes, 
toolsets and tools

ArcToolBox
ArcToolBox is used for data analysis as well automation of repetitive tasks. Commonly 
used tools include clipping (a cookie cutter operation), merging (combing data together) 
and buffering (creating concentric rings around features). ArcToolBox is a dockable window 
that can be added to either ArcMap or ArcCatalog.
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Analyzing

• Double click a tool to run
• Tools run as dialogs

– Browse for input data
– Specify output data
– Set tool parameters
– Run tool

• Review progress window for 
errors

Buffer toolBuffer tool

Progress windowProgress window

Tool dialogTool dialog

Analyzing
To run a tool, first find the tool in ArcToolBox. If you do not know where to find a tool, use 
the Search tab at the bottom of the ArcToolBox window. To run a tool simply double click 
on it (tools have a hammer icon next to them). Most tools run as dialog boxes requiring that 
you identify an input dataset, and output data location and tool parameters. Depending on 
the tool being run will determine the parameters required. The slide above shows the buffer 
tool, which requires you enter a buffer distance. When the dialog is complete click the OK 
button to run the tool and review the progress window for any errors.
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Exercise 1

• Start ArcMap
• Open a map document
• Symbolize a layer
• Start ArCatalog
• Examine a feature class
• Start ArcToolBox
• Run a tool
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Section 3:
Collection, scanning and indexing
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Section overview

• Data sources
• Scanning 
• Indexing

Section overview
The use of existing data assists in the creation of the cadastral index map as not all areas 
need to be surveyed. This section covers where to find existing data, its assessment, 
scanning and indexing.
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Objective

To gather existing data and convert to digital by 
scanning and data entry

EXISTING CADASTRAL DATA

- Mutation forms (apartments)
- ESA maps
- Geodetic data
- Other maps and plans

GATHER 
EXSITING DATA

CONVERT EXISTING DATA TO DIGITALCONVERT EXISTING DATA TO DIGITAL

ESAESA’’s roles role
--scan and digitize maps/plansscan and digitize maps/plans

--provide private sector with bldg/apt mutation form provide private sector with bldg/apt mutation form 
copiescopies

Private SectorPrivate Sector’’s role:s role:
--scan and index bldg/apt plansscan and index bldg/apt plans

--scan and index mutation form copiesscan and index mutation form copies

Objective
Rather than collect information from scratch, the methodology proposes that existing data 
sources be used to partially construct a cadastral index map. A large amount of information 
relating both land parcels and buildings is held by ESA District Offices and Municipalities, 
amongst others. The first activity within the preparatory phase will be the collection and 
evaluation of this information and to whether it should be included and if so to convert the 
data into digital format (if required). Where gaps exist these will be filled with new survey 
work. Existing mutation forms will also be scanned and indexed.
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Egyptian Survey Authority

• EDO
– Mutation forms 
– Development (Partitioning) Project Plans
– Building Unit Plans

• EPO
– Cadastral Maps
– Development (Partitioning) Project Plans
– Control Network data
– Cadastral Numbering

Egyptian Survey Authority
EDO (ESA District Office)
Mutation forms are used to record property transactions and provide diagrams of land 
parcels, common areas within buildings under multiple ownership and individual 
apartments. Mutation forms are created in a hierarchical manner and are a link between 
existing registered deeds and a spatial description of property objects. Individual mutation 
forms are slightly larger than A4.
Development (Partitioning) Project Plans are created by development companies and 
individuals undertaking subdivision.
Building Unit Plans are plans which show the internal details of individual apartments and 
are usually only available for new communities.
EPO (ESA Provincial Office)
Cadastral Maps for new communities are generally maintained in AutoCAD.
Development (Partitioning) Project Plans are created by development companies and 
individuals undertaking subdivision.
Control Network Data are low order control points for cadastral surveys and can be used in 
field survey work.
Cadastral Numbering a list of cadastral numbers is maintained by the EPO.
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ESA HQ

• Geodetic control
– Existing control points
– Datum conversion parameters

• Cadastral map data
– Existing cadastral maps

ESA HQ
Geodetic Network Data – The Department for Geodesy, Triangulation and Control, which 
comes under the Mapping Affairs Central Department, is responsible for managing and 
maintaining all geodetic infrastructure for Egypt’s vertical and horizontal control networks. 
This department may possess details information about the GPS stations to be the basis for 
the coordinate system that will be used by the surveyor to densify the network required 
within the target area to be surveyed and/or mapped. The department is also responsible
for developing and disseminating control network transformation parameters and equations 
so that all cadastral data is on the common coordinate datum of NED-95.  The coordinate 
values and description cards can be obtained from the ESA Geodetic Department.
Cadastral Map Data – The ESA Map Store holds a repository of cadastral maps for many
areas of Cairo at 1:500 to 1:2500 scale. Maps for the selected area to be surveyed should 
be collected to identify the property boundaries determined when the last survey was 
completed.
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Municipalities

• Land use types and patterns
– Residential and Government land

• Street names and public areas

Land use patternsLand use patterns

Municipalities
Data relevant to land registration and held by the municipalities includes:
Land Use Plans that show land use patterns and to some extent ownership information 
(e.g. whether it is residential or governmental land)
Municipal Property Data which indicates municipal property boundaries, public use areas
and approved road and street locations and names.
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Physical Planning

• Street names 
– New names
– Changes to names

• To confirm property address

Street NamesStreet Names

Physical Planning
Street names (current and old) are held by Physical Planning and can be used to confirm 
property addresses.
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Other Government Agencies

• Land ownership 
• Plans of buildings and properties
• Names of properties
• For reference purposes 

Other Government Agencies
Many other government agencies own land as well as properties and buildings, plans and 
names of which will be useful for reference purposes. Examples include the New 
Communities Agency.
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Private Companies and Individuals

• Developments by private companies
– Records of owners

• Individual ownership claims
– Sanad el-Melkyah
– ORFI contracts
– Notarized documents

Notarized DeedNotarized Deed

Private Companies and Individuals
Developers hold plans and maps of their developments which can be used to create 
cadastral data. This data is typically already in digital format (e.g. AutoCAD) and can 
relatively easily be combined with new data. For individuals any of the following can be 
used in determining ownership (in descending order of preference):
Registered Deed or Publicized contract
Registry Office extract or notarized documents
ORFI or Unregistered contracts
Adverse possession the acquisition of title to property through possession without the 
owner's consent for a certain period of time (by law 15 years in Egypt)
Tax statements or tax (MUKALAFA) registers
Testimony
Utility bills in order of importance, telephone or electricity, gas
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Data assessment

• Decide whether to use data
– Use only maps and plans with relevant features 
– Minimum acceptable scales
– Control Points required
– Age and condition

Data assessment
Existing locational information of land parcels must be sourced from paper based maps and 
plans and a scale of 1:500 or better. Existing digital data must have been created through 
methods with an accuracy that is equal to, or better than the graphical equivalent of 0.25m 
at 1:500 (0.5mm at map scale). The smallest scale from which data can be is sourced is 
1:5,000. If maps and plans do meet these minimum requirements they should not be used 
and field surveying will be required.
On maps being scanned you should be able to identify a minimum of 2 (preferably 3)control 
points (often referred to as Ground Control Points or GCPs), known locations that have real 
world coordinates associated with them. If no control points can be identified then a field 
survey will be required to establish these. The control points are needed to ensure that data 
can be brought under a common survey reference network.
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Data assessment form

• Record whether maps/plans can be used
• Indicate if survey work is required

No

Yes

Include in 
GIS?

Mokattam, 
Block C

Mokattam, 
Block A

Location

YesNoUnknown
1934?

Old cadastral 
map

NoYes1:5,000
1985

Developers plan

Field Work 
needed?

GCPsScale/
Age

Source

Data assessment form
Use a data assessment form to log data that has been gathered and record key information 
about it – its scale, age (if known), whether there are any visible GCPs and whether field 
work is needed, this information should be passed to the survey team so that they can 
program survey work as needed.
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Scanning

• Maps and plans up to A0
– Digitize features from raster data

• Mutation forms up to A3
– Index key attributes using RDBMS

Scanning
Only maps and plans with relevant information should be scanned (i.e. those showing 
buildings and parcels). Maps and plans should be scanned using an A0 scanner, mutation 
forms using an A3 scanner.
Once mutation forms have been scanned they should be indexed i.e. key details should be 
recorded in a relational database management system (RDBMS) such as MS Access.
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Scanning process

• Load plan, map or form in scanner
• Preview and adjust
• Save to TIFF format

Scanning process
To scan a map, plan or form, make sure it is face down and flat on the scanner, choose to 
preview the document before scanning so that you can be sure it is being scanned 
correctly. 
Maps, plans and mutation forms should be scanned as TIFF files (Tag Image File Format 
CCITT Group 4 compression standard). 
The graphics above show the Scanner and Camera Wizard in Windows XP, note that you 
may be using different scanning software but the process will be exactly the same.
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File naming convention

• Mutation forms - mutation form number
– Mutation5677723

• Maps - map sheet
• Apartment/Buildings plans - address

– Apartment no + Building no + address

File naming convention
Scanned TIFF files should be named after the number of the mutation form preceded by 
‘mutation’ as shown above. Maps should be named by map sheet number. 
Apartment/Building plans by address (Apartment #, Building # and address).
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Indexing mutation forms

• Key attributes to be recorded:
– Property location 

• Governorate name, Town name, District name, etc…
– Original contract details

• Name of contract party, type of transaction, transaction year, etc…
– Transactions against property

• Grantor, grantee, date of contract registration, transaction year, etc…

Indexing mutation forms
Mutation forms contain key attribute information that needs to be indexed. The key 
attributes to be recorded are listed on the following pages and relate to the property object, 
initial and subsequent transactions. Property sketch details will not be indexed.
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Time frame

• Estimated number of mutation forms for Mokattam:
– 2,600 for parcels
– 1,900 for apartments

• Each indexer should complete 20 mutation forms a day
• Approximate time frame 1 month (10 persons)

Time frame
There are approximately 4,500 mutation forms in Mokattam. Assuming a complement of 10 
GIS and Data processing staff indexing (recording) 20 mutation forms a day, all forms 
should be encoded within 1 month.
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Property details

• Property address, district, governorate…

Property addressProperty address

Property location
Information related to the property that needs to be encoded includes: Mutation form 
number, Governorate Name, Town (City) Name, District Name, Block Name (if applicable), 
Block Number (if applicable), Street Name, Land Parcel Number, Building Number (if 
applicable), Map Sheet number X coordinate, Map Sheet number Y coordinate, Land 
Parcel Mutation Form Number (this is entered for mutation forms of building common areas 
and apartments) and Apartment Number (this number is entered in place of building 
number and land parcel number. It is linked to the land parcel by inclusion of the land 
parcel mutation form number).
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Initial transaction

• Location, date, Grantor-grantee, nature of transaction:

Initial transactionInitial transaction

Initial transaction
Information regarding the original contract submitted for initial registration of the property 
object that needs to be encoded includes: Name of contract party that interest is issued 
against, Name of contract party that interest is issued to, Third Party to contract (if 
applicable), Transaction Application Number, Transaction Application Year.
Types of transaction:
The following types of transaction may be recorded on the mutation form: Consent Sale, 
Sale by keeping usufruct right, Seha we Nafaz Prosecution, Seha we Nafaz Verdict, Gift, 
Will, Formal Pledge List, Possession Pledge List, Formal Pledge List Renewal, Possession 
Pledge List Renewal, Consent Division, Juridical Division Prosecution, Juridical Division 
Verdict, Ownership Affirmation Prosecution, Ownership Consolidation Verdict, 
Expropriation Warning, Expropriation Prosecution, Verdict for Holding an Auction, 
Inheritance, Consent "Farz wa Tagneeb" (Partitioning and Separation), Consent + division 
& Particularization, "Farz wa Tagneeb" Prosecution (Partitioning and Separation), "Farz wa
Tagneeb" Verdict (Partitioning and Separation), Marginal notation, Publication Amendment 
(major), Publication Amendment (minor), Completing a Deal (Concluding a Transaction), 
Particularization, Expropriation decision for public benefit (compensated), Issuance of real 
estate certificate, Issuance of recent copy of a deed, Consent Sale with pledge, Assignment 
Prosecution, Will registration
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Subsequent transactions

• Grantor-Grantee, nature of transaction, date…

Subsequent 
transactions
Subsequent 
transactions

Subsequent transactions
Information related to subsequent transactions carried out against the property object that 
needs to be encoded includes: Contract Registration Number, Date of Contract 
Registration, Name of contract party that interest is issued against (Grantor), Name of 
contract party that interest in issued to (Grantee), Thor party to contract (if applicable), Type 
of Transaction, Transaction Application Number, Transaction Application Year.



Collection, scanning and indexing v0.2.ppt
Module B: ESA Cadastral Operations Course
Technical Report # 3-20

Sketch map

• A property outline and dimensions 

Property sketchProperty sketch

Sketch map
The sketch map (not to scale) records parcel or building dimensions. Information from this 
page will not be indexed, rather it will be linked to the parcel/building that it is associated 
with using hyperlinks in ArcGIS see Section 6: Preparing the cadastral index map for more 
details.
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Creating a Mutation forms database

• Use MS Access to create two tables:
– One for property object and initial transaction (Property Object)
– One for subsequent transactions (Subsequent Transactions)

• Add fields and define data types

Creating a Mutation forms database
Create the mutation forms database in MS Access. First create a new database called 
‘Mutation Forms.mdb’. Next create two tables one for the property object and the initial 
transaction that caused the mutation form the be created in the first instance and another 
for subsequent transactions. 
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Mutation form cardinality

• One to Many relationship
– One property has many transactions 

• Link tables using the Mutation Form Number field

56634825663482

Sold: 1984, Owner ASold: 1984, Owner A
Sold: 1990, Owner BSold: 1990, Owner B
Sold: 1996, Owner CSold: 1996, Owner C
Sold: 2000, Owner DSold: 2000, Owner D

Mutation form cardinality
Cardinality is the the correspondence or equivalency between rows in table. For example, if 
one row in a table corresponds to three rows in another table the cardinality is one to many 
(1:M) as in the case of a property (one object or row a the property object table) and sales 
transactions (many objects or rows in the subsequent transactions table). You can link the 
tables together using the common field ‘Mutation form number’ as shown below:
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Creating new tables

• Add fields and define properties

Creating new tables
In MS Access choose to ‘Create a table in Design view’, add the fields (appearing in the 
next slide) and define their properties e.g. whether the field is to store numbers or text and 
the field width. The required fields for the Property Object and Subsequent Transactions 
tables are described in more detail in the course exercises.
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Required fields

Property Object 
table’s fields

Property Object 
table’s fields

Subsequent 
transactions table’s 

fields

Subsequent 
transactions table’s 

fields

Required fields
The slide above shows the field names, data types and sizes of the fields in each table. 
Each table has the common field Mutation Form Number. You will notice field names have 
underscores instead of spaces, this is to ensure the tables are read correctly in ArcMap
although you can have spaces between words for fields in MS Access.
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Using forms to add records

• Use Forms to populate tables

Using forms for 
data entry

Using forms for 
data entry

Using forms to add records
To populate the Property and Subsequent Transactions tables create a form using the 
Design Wizard. Selecting a justified form will ensure all field names will be visible in the 
form. This is the easiest way to add records to your table.
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Exercise 2

• Create a new database
• Create tables
• Add fields
• Define field properties
• Index key mutation form attributes
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Section 4:
Geo-referencing data
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Section overview

• Transforming raster data
• Transforming vector data
• Adjusting vector data

Section overview
Whether it is scanned raster data or existing vector data, if the coordinates are incorrect the 
data must be geo-referenced to a common reference so that all layers align correctly. This 
section describes the different steps followed and the tools available in ArcGIS that can be 
used to perform this task.
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Objective

To geo-reference existing digital data to a common 
reference using known control points

CADASTRAL FIELDWORK & VERIFICATION OF 
EXISTING INFORMATION

ESA’s role
-Geo-reference existing parcel data

- Collect new or revised data for gaps

Private Sector’s role
-Geo-reference existing building data

- Survey building locations

PRIVATE SECTOR
-Geo-referenced bldg/apt 
locations
- Bldg/Apt location 
descriptions

GEODETIC CONTROL

ESA’s role
- High Order Network densification

-Convert existing control networks to common datum

Private Sector’s role
- Local Traverse Network densification

ESA
-Cadastral Index Map and 
parcel pans
- Cadastral numbering

Objective
The objective of this section geo-reference existing digital data to a common reference 
using known control points collected using GPS or Total Station, available from ESA or on 
the data itself.



Georeferencing data v0.2.ppt
Module B: ESA Cadastral Operations Course
Technical Report # 4-4

Spatial adjustment options

• Local coordinates to ETM?
– Use a transformation 

• Misalignment between features on imagery and map
– Use rubbersheeting

Spatial adjustment options
Depending on the problem with your data will determine what spatial adjustment solution 
should be applied. The most common situation you will encounter is data in local 
coordinates which must be transformed to ETM to be of any value and before it can be 
combined with new data acquired from field surveying. Minor inconsistencies in data (e.g. 
boundaries surveyed using GPS and Total station) can be corrected using Rubbersheeting, 
whilst misalignment along map sheet edges can be corrected using Edge snapping (see 
Section 6: Creating the Cadastral Index Map for more details). These problems should only 
be encountered with existing data, new data will be acquired directly to ETM and have 
minimal or no errors.
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Georeferencing overview

• For raster data
• Use the Georeferencing toolbar 
• Identify control points
• Apply transformation 

Add Control Points toolAdd Control Points tool

Georeferencing overview
To georeference raster data recorded in a local coordinate system – for example maps that 
have been scanned, use the Georeferencing toolbar in ArcMap. You can assess the 
success of the transformation by viewing the link table. An acceptable RMS is based on the 
scale of the source data. Refer to the slides on Spatial Adjustment in this section for more 
details.
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Getting started

• Select image to work with
• Fit image to display 

– Scales image to a reference layer

Getting started
First align the raster data in the general vicinity reference layer. From the 
Georeferencing toolbar select the raster layer you want to georeference from the 
Layer: drop-down menu. From the Georeferencing drop-down menu choose Fit to 
Display. The raster layer will now appear in the same area as the reference layer (it 
will not be an exact match). You can also use the Flip or Rotate tools to move the 
raster layer as needed so that it more closely fits the reference layer.
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Adding control points

• Use Add Control Points tool
– Identify point on image 
– Identify identical point on 

reference layer 

Adding control pointsAdding control points

Adding control points
You add control points as follows (you should add at least 3). Using the Add Control 
Points tool click at a location on the image. The location on the image layer will be 
identified by a green cross. Press the Esc key to remove a link while you’re in the 
process of creating it. Next click on the corresponding location on the reference layer. 
Note: It is best to zoom in so that you can see these locations as clearly as possible. 
The location on the reference layer will be identified by a red cross. If Auto Adjust is 
ticked on, as you add control points the image will be transformed or warped. Warping 
uses an affine transformation to shift, scale, and rotate your raster using a minimum of 
three links. Any more than three links introduces errors, or residuals, that are 
distributed throughout all the links. In practice, add more than three links. Given only 
three, if one link is positionally wrong, it has a much greater impact on the 
transformation. Thus, even though the mathematical transformation error may increase 
as you create more links, the overall accuracy of the transformation will increase as 
well.
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Assessing success

• View errors in Link table
– Shows image coordinates and map coordinates
– Reports residual (individual) and total error

• Save georeferencing information with image

Assessing successAssessing success

Assessing success
Click the View Link Table tool to evaluate the transformation. You can examine the 
residual error for each link and the overall RMS error. If you’re satisfied with the 
registration, you can stop entering links, or you can delete an unwanted link from the 
Link Table dialog box.
To update the image’s georeferencing and choose Update Georeferencing from the 
Georeferencing drop-down menu. A world header file with the w extension will be 
written to the image directory (e.g. a JPEG world file is *.JGW and a TIF world file is 
*.TFW) which records the image’s spatial reference ensuring it sits correctly in terms 
of geography whenever added to a map document in future. 
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Spatial adjustment overview 

• For vector data
• Use the Spatial Adjustment toolbar 

– Must be editing

• Identify displacement links 
• Select adjustment method

– Transformation, Rubbersheeting or Edge snapping

Add Displacement Link toolAdd Displacement Link tool

Spatial adjustment overview
To georeference vector data use the Spatial Adjustment toolbar. You must be editing the 
source data. First add displacement links. Once you have added displacement links select 
the adjustment method to use, if you are performing a transformation you can assess the 
accuracy of that transformation by viewing the link table.
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Displacement links

• Graphic elements define the source and destination
• Create manually or load from links or control point file

400,600?400,600?

400,000mE, 800,000mN400,000mE, 800,000mN

SourceSource DestinationDestination

Displacement LinkDisplacement Link

Displacement links
A link is a displacement vector that represents a source location to a destination location. 
There are three ways you can add displacement links (i) interactively, use the mouse to 
locate source and destination coordinates; (ii) using a Control Points file, a text file which 
contains a displacement link ID and destination coordinates (X,Y), in which case you will 
be required to identify the source coordinates interactively; (iii) using a Link File, a text 
file which contains a displacement link ID, source and destination coordinates (X,Y). 
Links are graphic elements in a map and are always displayed as arrows with the 
arrowhead pointing towards the destination. You can change the symbol, size, and 
colour of displacement links from the Adjustment Properties dialogue from the Options 
command on the Spatial Adjustment menu. The Spatial Adjustment toolbar has tools to 
manually add a displacement link, to modify an existing link, and a tool to automatically 
add multiple links between two selected features. The current snap environment is 
honoured when manually adding displacement links. 
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Adding links manually

• Define source and destination coordinates interactively
• Snap environment is honoured when adding links

Displacement link 
tool

Displacement link 
tool

Adding links manually
Use the New Displacement Link tool to add links manually, make sure you get the 
sequence the right way round, click on a source location then a destination location. A new 
displacement link will be added. You can change the symbology of the displacement link 
(choose Spatial Adjustment > Options… and click on the current displacement link symbol 
to change it). To delete displacement links use the Select Elements tool to select a link, 
then press the Delete key on the keyboard. To save coordinates placed manually choose 
Spatial Adjustment > Links > Save Links File….
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Using a Control Points file

• Text file contains destination coordinates
• Define source coordinates interactively

Control Points FileControl Points File

Using a Control Points file
You can also create links based on a control points file. A control points file contains the X 
and Y destination coordinates and may contain ID values for each record. When a control 
points file is opened, the Control Points Window dialog will open and display the coordinate 
locations. These locations will become destination points for new displacement links. 
Double-clicking or right-clicking and choosing Add link will create a link starting at the 
destination coordinate, and then you can manually add the source location. 
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Using a Link file

• A text file contains source and destination coordinates
• Displacement links added automatically

Link TableLink Table

Using a Link file
You can also create links from coordinates saved in a link file. A link file is a text file that 
contains a list of X, Y source and X, Y destination coordinates. A link file can be comma, 
space, or tab delimited and may contain ID values that precede each record. When you 
open a links file from the Links submenu, the source and destination displacement links will 
be automatically created based on the coordinate locations in the link file.
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Transformation

• Adjustment applied equally to all features in a layer
• Used to change from one coordinate system to another

• Features are scaled and moved
• Relative location preserved

Transform local to ETM 
coordinates

Transform local to ETM 
coordinates

Transformation
Transformation is used to fit datasets together. It applies a consistent combination of 
rotation (spinning), translation (moving), scaling (making the data bigger or smaller) to the 
entire layer or selected features in the layer. Since every part of the layer undergoes the 
same transformation the relative location of each point to the others is preserved. 
Depending on the transformation used determines whether data is scaled, rotated and 
translated or scaled, rotated, translated and skewed (parallel lines remain parallel). In order 
to be able to perform a transformation both source and destination coordinates are 
required. The error of the transformation method can be assessed by means of the Root 
Mean Square Error (RMS).
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Transformation methods

• Transform will translate, rotate, and scale data 
• Use Similarity, Affine, or Projective method
• Affine transformation can:

RotateRotate
TranslateTranslate

SkewSkew

ScaleScale

Transformation methods
Depending on the method used to transform your data from one coordinate system 
to another, the transformation may translate or shift features in coordinate space, 
scale features in size, rotate, or skew them. ArcGIS supports the three 
transformation methods summarised below. The ArcGIS Help provides more 
information on the mathematical functions used for the transformations.
Similarity 
This method is also sometimes referred to as an orthogonal or two-dimensional 
linear conformal transformation. It is commonly used to adjust data between two 
similar coordinate systems; for example, to change the map units of data from one 
linear unit to another. This method will translate, rotate, and scale features. At least 
two displacement links are required for this four parameter transformation.
Affine
This method expands on the similarity transformation by allowing two scale factors 
instead of one, and will allow features to be skewed while being rotated. There is a 
minimum of three links required to perform this six parameter transformation. 
Transforming digitised data to real world coordinates is a good example where this 
transformation is applicable, as it allows for the small distortions such as stretch, 
shrink, and skew that occur to paper and other media that are digitised.
Projective
This is a specialised transformation used to transform coordinates digitised directly 
off high altitude aerial photography or aerial photographs of relatively flat terrain. It is 
an eight parameter transformation and requires a minimum of four links to perform.
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Transformation accuracy

• Acceptable levels of RMS (average figure in metres)

• Acceptable error is larger for smaller map scales
• Only reported for transformations

2.52.51:25,0001:25,000
221:10,0001:10,000
111:5,0001:5,000

0.20.21:1,0001:1,000

Acceptable RMSScale of map/data

Transformation accuracy
Use the RMS reported in the table above to determine whether the transformation has 
achieved an acceptable level of accuracy. An acceptable RMS increases with scale. An 
RMS error is only reported for transformations not rubbersheeting or edge matching.
Root Mean Square Error
A root mean square error (RMS) describes the deviation that will occur when the 
transformation is applied to the input and the output coordinate systems. The error is 
determined using the least squares regression method. The transformation parameters are 
a best-fit between the source and destination control points. If you use the transformation 
parameters to transform the actual source control points, the transformed output locations 
won’t be an exact match to the true output control point locations. This is called the residual 
error; it is a measure of the fit between the true locations and the transformed locations of 
the output control points.
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Assessing the RMS

• View the Link Table
• Can assess error before performing adjustment
• Delete links contributing largest error

Link Table shows 
overall RMS error

Link Table shows 
overall RMS error

Assessing the RMS
To see the overall RMS of the transformation, choose Spatial Adjustment > Links > View 
Link Table. Assess the residual for each point and the overall RMS error and determine 
whether the transformation is acceptable. To delete displacement links which are 
contributing the greatest error select them in the table and click the Delete Link button or 
press the Delete key on the keyboard.
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Performing a transformation

• Select layer that adjustment will be applied to
• Select Adjustment Method
• Apply adjustment 

Applying a 
transformation to 

selected layers

Applying a 
transformation to 

selected layers

Performing a transformation
Once you have added displacement links you are ready to perform a transformation. First 
specify which data can be adjusted either (i) any selected features or (ii) all features in 
specific layers. Next choose a transformation method: Affine (the default), Projective or 
Similarity. Use Affine for vector data derived from scanned maps and plans and Similarity 
for CAD data from the New Communities or ESA. You will not use Projective which is used 
specifically for data digitized from aerial photography. Lastly choose Adjust from Spatial 
Adjustment menu to adjust the data. If this option is greyed out then you have not added 
enough displacement links for the selected transformation method or no features are 
selected.
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Rubbersheeting

• Features are stretched, straight lines preserved
• Different transformations in different parts of the map

– Some points move a small distance, others further

Discrepancies between 
features are inconsistent
Discrepancies between 

features are inconsistent

Rubbersheeting
Geometric distortions commonly occur in data. They may be introduced by imperfect 
registration in map compilation, lack of geodetic control in source data, or a variety of 
other causes. Rubbersheeting corrects flaws through the geometric adjustment of 
coordinates as such the relative locations of points, unlike a transformation, are not 
maintained, as some points move a small distance others further.
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Performing Rubbersheeting

• Place Identity Links – fixed locations
• Define adjustment area – features move within this area
• Add displacement links – source/destination coordinates

Limited Adjustment areaLimited Adjustment area

Identity LinkIdentity Link

Displacement LinksDisplacement Links

Performing Rubbersheeting
An Identity Link is a link whose source and destination coordinate are the same. Identity 
links act like nails to hold specific locations in place. After an adjustment, displacement links 
become identity links. Identity links can also be added manually with the Identity link tool on 
the Spatial Adjustment toolbar. The Limit Adjustment Area tool allows you to draw a 
polygon around the features you want to adjust. This allows you to limit your adjustment to 
the area covered by the added polygon. Features outside the area will not be adjusted. At 
least one displacement link is required to perform the rubbersheeting adjustment. 
Rubbersheeting can be performed on a selected set of features to fit them to another set of 
features. For example, a lakeshore in one layer could be rubbersheeted to match a more 
accurate boundary in another layer. You can also perform rubbersheeting on all features in 
a feature class or feature dataset to another control dataset. That dataset could be a raster 
image as in the graphic above, a CAD drawing, locations specified interactively, 
coordinates in a text file, or coordinates interactively entered into a table.
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Exercises 3, 4 & 5

• Exercise 3
– Geoference raster data

• Exercise 4
– Convert CAD data to shapefile format
– Start Editing
– Load Links file
– Transform layer

• Exercise 5
– Start Editing
– Load Control Points file
– Rubbersheet features
– Use Editing tools to correct residual misalignment
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Section 5:
Processing cadastral data
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Section overview

• Data creation
• Heads up digitizing
• Tracing
• Conversion

Section overview
This section describes how to create new data in ArcGIS using heads up digitizing, tracing 
and data conversion. Once buildings and parcels have been captured they will then be 
assigned a property identifier.
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Objective

To capture and attribute buildings and parcels by means 
of digitizing and data conversion

Objective
The objective is to capture parcels and buildings, attribute the features and create a 
cadastral database for the Mokattam area.
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Data processing options

• Existing data
– Heads up digitizing
– Table digitizing
– Data conversion

• New data
– Heads up digitizing
– Data Conversion

Data processing options
Existing data can be processed in different ways depending on its format and geometry:
• If data is either raster or vector line format it can digitized by means of heads up 

digitizing. You will be required to create a new feature class before digitizing.
• If the data is in analogue format it can be digitized using a table digitizer. You will be 

required to create a new feature class before digitizing.
• If the data is vector polygon format but is not in an ESRI spatial format it can be 

converted (assuming it is supported, see Section 2: ArcGIS Refresher for more details). 
You will not need to create a new feature class, the conversion process will create one 
for you automatically.

New data in AutoCAD format will be processed by heads up digitizing or data conversion.
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Heads up digitizing - raster

• Retrace features on raster data 
– Trace line’s accuracy based on operator’s ability

Retrace features 
on screen using 

the mouse

Retrace features 
on screen using 

the mouse

Heads up digitizing - raster
Once maps and plans have been scanned the raster data will be converted to vector data 
by means of heads up digitizing (this will also be the method used to capture features from 
aerial photograph or satellite imagery). Using the mouse, the cells in the raster data 
representing building footprints or parcel boundaries and simply re-drawn to create 
polygons. The accuracy of the polygons created are only as good as the ability of the 
operator since they can only visualize draw lines.
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Heads up digitizing – vector line

• Trace lines to create polygons
– Trace line is exact 

Retrace features 
on screen using 

the mouse

Retrace features 
on screen using 

the mouse

Heads up digitizing – vector line
Tracing vector data is more accurate as you actually snap to the line being traced. In 
ArcGIS you select the lines to trace and simply follow them to construct a polygon, this 
method of heads up digitizing is the most accurate of all. Note: You will use this method to 
create polygons from new field survey data as well if it has been captured as polylines.
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Table digitizing

• Retrace features using a puck
– Trace line’s accuracy based on operator’s ability

Retrace features on 
the paper map using 

a puck

Retrace features on 
the paper map using 

a puck

Table digitizing
If all that is received is paper maps, then you can consider table digitizing rather than 
scanning. To digitize from paper maps, first asses the map quality if it is acceptable affix the 
map firmly to the digitizing table it should not move. Next configure the digitizer puck 
buttons. You should configure one of the buttons to perform a left mouse-click so you can 
digitize points and vertices of lines. You will want to configure another button to perform a 
left double-click to finish digitising lines or polygons.
Next establish control points (or registration points) on the paper map. Identify a minimum 
of four known points. If your paper map has a grid or a set of known points on the ground 
you can use these. Otherwise choose known real-world features such as road junctions 
and mark them on the map. Give each one a unique number and ensure you know the 
actual ground co-ordinates. Choose places that are as far from each other as is practicable.
Finally register the paper map. Registering the map involves recording the ground co-
ordinates for each of the control points you identified.  
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Data conversion

• Use data conversion tools if CAD data represents 
properties as polygons

DWG

DXF

Shapefile

Data conversion
Data held in AutoCAD format (DWG or DXF) will be converted to an directly to an ESRI 
spatial format (e.g. shapefile) only if parcels/buildings are represented as polygons (i.e. 
closed polylines). If the properties are represented as polylines then the lines will be traced.
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Creating a new feature class

• Create new feature class in ArcCatalog or ArcToolBox
• Specify spatial format, geometry type, spatial reference

ArcToolBoxArcToolBox

ArcCatalogArcCatalog

Creating a new feature class
You can create a new feature class in either ArcCatalog or ArcToolBox; when creating a 
new feature class specify the spatial format (i.e. shapefile or personal GDB feature class), a 
geometry type (i.e. point, line or polygon) and spatial reference (e.g. ETM). To create a new 
shapefile in ArcCatalog right click on a folder (e.g. C:\TEMP) and choose New > 
Shapefile…. from the context menu. To create new data in ArcToolBox navigate the Data 
Management Tools > Feature Class toolset and double click on the Create Feature Class 
tool.
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Defining a spatial reference

• Assign a coordinate system to new data

Egypt Red BeltEgypt Red Belt

Defining a spatial for reference 
Having created your new feature class, you can define its spatial reference. 
Whenever you create a new feature class its spatial reference is set to ‘Unknown’. To 
assign a spatial reference to a new shapefile click the Edit… button in the Create 
New Shapefile dialog box. In the Spatial Reference Properties dialog box click the 
Select… button. In the Browse for Coordinate Systems dialog box choose Projected 
Coordinate Systems > National Grids > Egypt Red Belt.prj. The parameters of the 
ETM are as follows:
Projection: Transverse_Mercator

False_Easting: 615000.000000

False_Northing: 810000.000000

Central_Meridian: 31.000000

Scale_Factor: 1.000000

Latitude_Of_Origin: 30.000000

Linear Unit: Meter (1.000000)

Datum: D_Egypt_1907

Spheroid: Helmert_1906
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Required feature classes

• One for parcels
• One for buildings

Both feature classes 
are polygons

Both feature classes 
are polygons

Required feature classes
You will create two feature classes, one for buildings and one for parcels. These are both 
polygon features classes and will be assigned Egypt_Red_Belt.prj projected coordinate 
system. The Buildings feature class will contain building footprints and apartments and the 
parcels feature class will contain parcel boundaries.
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Adding fields

• Must not be editing
• Specify name, data type and width for field:

– Name must be unique 
– Reserved words e.g. Count, Value, etc

Adding a field 
in ArcMap

Adding a field 
in ArcMap

Adding fields
To add fields make sure you are not editing the source data. In ArcMap right click on the 
Layer and choose ‘Open Attribute Table’ from the context menu. In the Table window click 
the Options… button and choose Add Field… from the pop-up menu. If the option Add 
Field… is greyed out either you are editing the source data or you do not have write 
permission on it. When you add a field give the field a unique name and set its properties. 
Be careful though, once you have added a field you cannot change its properties. Certain 
names are reserved e.g. Count, if you try to use these words you will be prompted to use 
an alternative e.g. Count_. 
Note: Field names can be a maximum of 10 characters in shapefiles, any longer and the 
name will be truncated, however, you can always use an alias to make the field name more 
understandable.
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Required fields – Parcels

• Parcels feature class:
– Real Estate Number
– Parcel Number
– Mutation Form Number

Parcel fieldsParcel fields

Required fields - Parcels
The Parcels layer will require the following fields (the field name added to the attribute table 
is shown in brackets): Real Estate Number (REN), Parcel Number (Parcel_No) and
Mutation Form Number (Mut_Frm_No). Remember you can set an alias to make these 
fields more meaningful.
The graphic above shows the field names, data types and widths for these fields. The Real 
Estate Number (REN) will be used to store the new property number being developed by 
ESA/MSAD. 
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Required fields - Buildings

• Buildings feature class:
– Real Estate Number
– Mutation Form Number
– Parcel Number
– Building Number
– Building Name
– Apartment Number
– Street Name
– District
– City
– Status

Building/apartment 
fields

Building/apartment 
fields

Required fields – Buildings
The Buildings layer will require the following fields: Real Estate Number (REN), Mutation 
Form Number (Mut_Frm_No), Building Number (Build_No), Building Name (Build_Name) 
Apartment Number (Apt_No), Parcel Number (Parcel_No), Street Name (Str_Name), 
District, City and Status (e.g. Occupied, Unoccupied, Under Construction). Remember you 
can set an alias to make these fields more meaningful.
The graphic above shows the field names, data types and widths for these fields. The Real 
Estate Number (REN) will be used to store the new property number being developed by 
ESA/MSAD. 
Communal areas in buildings should be given an apartment number of -99. Cadastral Index 
maps must show major buildings’ name, hence the field Building Name which can be used 
for labeling (see Section 6: Creating the Cadastral Index Map for more details).
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Geometry fields

• Add geometry fields to attribute table
• Area and perimeter fields required

Area field propertiesArea field properties

350000789128967238901350000789128967238901

Area: 600 sq metres
Perimeter: 1700 metres

Geometry fields
If you create shapefiles you must add area and perimeter fields to track geometry. Use the 
field calculator to calculate these values (see the slide Calculating Geometry Values in this 
section for more details). The data type of geometry fields should be double (double 
precision, real number). Note: that the area and perimeter figures calculated for apartments 
will not be correct as the polygons are indicative of ownership not the actual representation 
of the apartment’s dimensions. If you make a mistake defining these geometry fields, they 
must be deleted and added again. Whenever edit features in a shapefile you must re-
calculate geometry figures, this is not done for you automatically.
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Editing in ArcMap

• Start an edit session
• Use Editor toolbar to set:

– Target layer (layer in which edits are being made)
– Task (what is being done)
– Sketch tool (how to draw features)

Edit toolEdit tool

Sketch toolsSketch tools

TaskTask Target LayerTarget Layer Attributes toolAttributes tool

Editing in ArcMap
If you have started an edit session (in the Editor toolbar choose Editor > Start Editing) and 
the layers come from more than one storage location (i.e. more than one personal 
geodatabase or network file directory), you will be prompted to select the single data source 
to edit. Once you have started an edit session you can set the snap options. To begin 
editing set the target layer – the layer in which features are being captured, the task – which 
controls how the sketch tool will work and a select sketch tool – which determines how a 
feature will be drawn from the Sketch tools drop-down list.
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Snapping

• Snap to any vector layer 
• Set tolerance
• Set ‘snap to’ objects in vector layers

Tolerance Snap environmentSnap environment

Snapping optionsSnapping options

Snapping
Snapping automatically moves your pointer to the location or orientation (parallel or 
perpendicular) of a feature. This prevents you from having to click the exact coordinate of a 
feature in order to connect the feature you are editing. The snapping tolerance is the 
distance the pointer must be to a feature before it snaps to that location. You can set the 
snapping tolerance in map units or pixels through Options from the Editor menu. There are 
two general varieties of snapping in ArcMap: Layer snapping: Moves your pointer to the 
location of a feature’s edge, vertex, or endpoint. You can decide which, if any, of these 
options will be available for snapping. Sketch snapping: When adding a sketch, this option 
will snap your pointer to a location perpendicular to the previous sketch segment. The 
snapping can be overridden if you move your pointer far enough.
Setting the proper tolerance for snapping is sometimes a trial and error process. You 
should try the default tolerance first and then change it in small intervals until you settle on 
one that is appropriate to the data and your needs
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Setting the target layer

• Set before digitizing features
– Parcels or Buildings

Setting the 
target layer
Setting the 
target layer

Setting the target layer
Make sure you set the target layer before digitizing, from the Target: drop down menu 
choose either Parcels or Buildings. Once the target layer has been set all edits will be made 
to this layer. You can switch between layers at any time when digitizing using the drop-
down menu. 
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Creating existing properties

• Create properties by digitizing
– Raster data

• Create properties by tracing 
– Vector data

Creating existing properties
There are two methods you can use to create new properties (parcels and buildings). If you 
are working with raster data you will use the Sketch tool to create new polygons. If you are 
working with vector data you will use the trace tool.
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Digitizing

• Use Sketch tool

• Left click to place vertices, double-click to finish

• Made a mistake? CTRL + Z

You can also pressYou can also press
F2 or right clickF2 or right click
and choose Finish and choose Finish 
Sketch to create a Sketch to create a 
featurefeature

Digitizing 
Use the Sketch tool to approximate lines appearing on a scanned image (i.e. perform 
heads up digitizing from raster data). To start a sketch click once with the left hand button of 
the mouse and place additional vertices (green boxes) by continuing to click the left hand 
button of the mouse. The more vertices you place the accurate the line or  boundary you 
are digitizing To finish the sketch and create a polygon, double click the left hand button of 
the mouse, press the F2 key on the keyboard or right click the mouse and choose Finish 
Sketch from the context menu. If you make mistake whilst digitizing press the CTRL + Z 
keys on the keyboard. Each time you press CTRL + Z you remove a vertex that has been 
placed.
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Setting segment and vertex properties

• Specify segment length, direction or both
• Add, delete, move a vertex

Sketch tool 
context 
menu

Sketch tool 
context 
menu

Sketch 
context 
menu

Sketch 
context 
menu

Setting segment and vertex properties
When using the Sketch tool, you can access the Sketch tool context menu by right-clicking 
the mouse away from the sketch you are creating.  The context menu has options for 
placing the vertices and segments specifically where you want them. For example, you can 
set a segment to be a certain Length (using any unit of measure e.g. ft, km, in, m) or 
Direction (angle based counter clockwise from the horizontal) or both; create a vertex at a 
specific x,y co-ordinate location (Absolute X, Y…) or make a segment parallel or 
perpendicular to another feature (Parallel, Perpendicular). The Sketch context menu works 
more directly with the sketch as a whole. With this menu, you can: Add vertices, Move 
vertices, Delete vertices, Switch the direction of the sketch, Reduce the length of the sketch 
and display the properties of the sketch. 
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Tracing

• Trace selected polylines to create polygons

AutoCAD Drawing 
file

AutoCAD Drawing 
file

Trace selected lines 
in ArcGIS

Trace selected lines 
in ArcGIS

Create polygonCreate polygon

Tracing
Using the Trace sketch tool you can trace selected lines to create polygons. Use the Edit 
tool in the Editor toolbar to select the lines to trace (use the SHIFT key to select more than 
one line). From the Sketch tools drop-down list select the Trace tool. Click once anywhere 
on a selected line to start a trace line. You do not need to click the left hand button of the 
mouse at any time, simply keep moving. You will see a thin black line representing the 
trace line. To finish a trace line double click the left hand button of the mouse. A polygon 
feature will be created.
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Creating adjacent polygons

• Use Auto-complete polygon task
– Ensures adjacency – no gaps

• Use Sketch or Trace tool to capture adjacent polygon

Creating adjacent polygons
The Auto Complete Polygon task will allow you to add a polygon to the edge of existing 
ones without having to sketch a duplicate boundary between them. Using this task you 
sketch all the polygon boundaries except the one common to the other adjacent polygon(s).
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Describing properties

• Existing features may be described by a mutation form
– Details held in mutation database will be linked to the property

• A parcel’s mutation form found by Land Parcel Number
• A building’s mutation form found by Land Parcel Number 

or address

Describing features
Existing features may be described by mutation form, if the process of registration has 
begun, but this does not mean the property has been registered, this would have to be 
confirmed with the REPD office. The Parcel number and Building address can be used to 
locate mutation forms held by the EDO. This process is described in the following slides.
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Attributing parcels

• Record land parcel number from ESA cadastral map

• Use Land Parcel Number to search for mutation form

A cadastral map showing 
land parcel number

A cadastral map showing 
land parcel number

Attributing parcels
Existing cadastral index maps should have land parcel numbers on them. You can use the 
land parcel number to find the parcel’s mutation form at the EDO.
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Attributing buildings

• Search for building’s mutation form 
– Using Land Parcel number
– Using Building address 

Land parcel, common area 
and building mutation 

forms 

Land parcel, common area 
and building mutation 

forms 

Attributing buildings
You can use the land parcel number of the parcel that the building sits within to search for 
the building’s mutation form in the EDO or you can use the building’s address to search for 
its mutation form if this information is written or recorded on the existing cadastral index 
map.
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Updating a property’s attributes

• Must be editing
• Make sure feature is selected, use the Edit tool
• Use Attributes tool 
• Type in attribute values

Updating a property’s attributes
Once you have found a mutation form for a parcel or building you can update its attributes. 
To update a property's attributes make sure you are editing, use the Edit tool to select the 
feature or features of interest and click the Attributes tool in the Editor toolbar. Under the 
Value column in the Attributes dialog box, click next to attribute (or field) to update, type in a 
value and press the Enter key on the keyboard. Make sure you choose to save your edits 
before quitting. 
Note: to add an address to new buildings use the Building Report completed by the Field 
Survey teams:

Field teams will complete 
Building reports, this is an 

example

Field teams will complete 
Building reports, this is an 

example
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Capturing apartments

• Copy and paste ‘ground floor’ polygon

Copying and pasting 
polygons

Copying and pasting 
polygons

Assigning each apartment 
an identifier

Assigning each apartment 
an identifier

Capturing apartments
Dealing with apartments might seem problematic, the easiest way is to copy and paste the 
ground floor communal area for each apartment that has a mutation form associated with it. 
It is important to emphasize that the polygon representing the apartment is indicative only, 
i.e. it shows that there is an area of ownership it is not meant to represent the apartment’s 
exact dimensions or area, it is the mutation form that depicts the dimensions of the 
apartment and the associated communal area (although not to scale). 
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Calculating geometry fields

• Use the Field Calculator to update record values

Calculating the 
area of polygons 
for an Area field

Calculating the 
area of polygons 
for an Area field

Calculating geometry fields
If you create a shapefile you must calculate area, perimeter and length fields to track 
geometry. Every time you edit a feature you must re-calculate the geometry fields. In the 
Field Calculator click the help button to access sample code for simple calculations, you 
can copy and paste this code into the field calculator. For example to calculate the area of a 
polygon right click on the Area field and choose Calculate Values from the context menu. In 
the Field Calculator dialog bix check the ‘Advanced’ option. Type this code into the ‘Pre-
Logic VBA Script Code’ box:
Dim Output as double
Dim pArea as Iarea
Set pArea = [shape]
Output = pArea.area

And then type Output in the ‘Area =‘ box. Click the OK button to update the area of the 
polygon. The figure will be in square meters (the units of the ETM).
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Saving edits

• Saving edits
– During the edit session
– At the end of the edit session

Saving edits

In ArcMap, you begin, end, and save edit sessions using the Editor menu on the Editor 
toolbar. When ending an edit session, ArcMap will prompt you to save your edits. If you do 
not save, your edits will not be committed back to the edit layer.
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Processing new data

• Field surveying teams will generate AutoCAD drawings
• Already georeferenced to ETM 
• Using Trace tool if properties recorded as polylines
• Convert drawing file if properties recorded as polygons

Processing new data
Survey crews will gather parcel outlines and building footprints using Total Station and 
Hand Laser distance tools. All data collected in the field will be processed using AutoCAD. 
Polygons can then be created using the Trace tool described in this section if data is 
provided as polylines or converted (see next slide) if provided as polygons. Note: Field data 
will directly georeferenced to ETM in the field and will not need to be transformed in 
ArcGIS.
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Data conversion process

• ArcToolBox
– Feature Class to Shapefile 

or Geodatabase

• ArcMap
– Export CAD layer

ArcToolBoxArcToolBox

ArcMapArcMap

Data conversion process
You can convert CAD data to a shapefile or personal geodatabase feature class in ArcMap, 
ArcCatalog or ArcToolbox. To export the CAD layer from ArcMap, right click on the layer 
and choose Data > Export Data… from the context menu (this is the easiest way to convert 
CAD data, you simply specify an output directory location and format). You can then add 
the required fields and edit data on conversion as described in this section.
To convert CAD data in ArcToolBox use the Feature Class to Shapefile or Feature Class to 
Geodatabase tool.
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Exercises 6, 7 & 8

• Exercise 6
– Convert CAD to shapefile
– Create new feature class
– Start Editing
– Trace CAD polylines

• Exercise 7
– Create new feature class
– Digitize satellite imagery

• Exercise 8
– Capture apartments
– Attribute apartments
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Section 6:
Preparing the cadastral index map
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Section overview

• Edge matching
• Merging data 
• Hyperlinks and joins
• Producing a cartographic product

Section overview
This section covers the steps followed to create the cadastral index map namely edge 
matching, merging of data, establishing hyperlinks, using joins and relates and the 
cartographic process.
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Objective

To prepare a cadastral index map showing parcels and 
buildings

PREPARATION OF PRELIMINARY 
CADASTRAL DATA

ESA’s role
-Merge parcel and building location data

- Perform quality control
-Index scanned images against parcel 

numbers
-Prepare list of all properties

PRELIMINARY CADASTRAL 
DATA

Index Map
Parcel plans
Apartment plans (if they exist)
List of all property objects

Submit to ESA for 
merging and 

approval

ESA 
-Cadastral Index Map & 
parcel plans
-Cadastral numbering

ESAPrivate Sector

Objective
The objective is to prepare a cadastral index map by merging field data with existing data, 
gathered by ESA and the private sector and performing quality control. 
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Edge matching

• Aligns features in adjoining layers if there is mismatch

• Adjustment options determine result:
– Adjust to an average location
– Only match if attribute values are the same

Sheet ASheet A

Sheet BSheet B

Features adjusted 
at map sheet edge
Features adjusted 
at map sheet edge

Edge Snapping
Edge snap (edge matching) uses rubber sheeting to match features along the edges of layers. 
If you are combining data from different sources, features may not align perfectly along the 
borders. The edge snap adjustment can be used to move the features in a source layer to 
match those in a target layer or to adjust to the midpoints of the links. When performing an 
edge snap, you can add displacement links manually, from a file, or automatically using the 
Edge Snap tool on the Spatial Adjustment toolbar. The Edge Snap tool allows you to drag a 
box over the source and target features to be edge matched. Links will be automatically 
added between source and target features that are within the current snapping tolerance set 
for the edit session.
The Edge Snap adjustment method requires more property settings than other methods. 
Properties can be set in the Edge Match panel of the Adjustment Properties dialogue box 
(options command on the Spatial Adjustment pull down menu).
When using the Smooth edge snap method, vertices at the link source point are moved to the 
destination point. Remaining vertices are also moved, giving an overall smoothing effect.  
When using the Line edge snap method, only the vertices at the link source point are moved 
to the destination point. The remaining vertices on the feature remain unchanged. 
You have the option to specify one link per destination point and to prevent duplicate links. 
The Spatial Adjustment tool supports the ability to use attributes to enhance the edge 
matching process. Based on the Attribute Transfer Mapping dialog box, you can match fields 
between the source and target layers and use common attributes to define the edge match. 
This function can help ensure the accuracy of the edge match. 
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Performing Edge matching

• Specify features which move – based on accuracy
• Set source and target (destination) layer
• Specify options - match options, line options
• Add displacement links (source -> target)

Performing Edge Snapping
To perform edge snapping you must be editing and using the Spatial Adjustment tool (refer 
to Section 4: Georeferencing Data for more details). First specify which features will move,
for example you may specify that features in the less accurate layer can move – if you know 
which layer is less accurate, or you may decide that both layers are as inaccurate as each 
other and therefore features in both layers can move. Next set the source and target layers 
making sure when you add displacement links that you adhere to the source/target layers 
set. Options can be set when performing edge matching – you can use attributes to 
determine whether displacement links can be added or not, if attribute values are the same 
a displacement link will be added, otherwise it will not. Once data has been checked for a 
consistency along map sheet edges it can be combined together.
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Merging data

• Combine existing and new field data together
• Build a complete cadastral index map for an area

Buildings absentBuildings absent

Buildings surveyedBuildings surveyed

Buildings CompleteBuildings Complete

Merging data
Data collected in the field and existing data will be combined together to create a complete 
picture of cadastral information for the pilot area. In addition data collected by the private 
sector (buildings) will also be combined with data collected by ESA (parcels). Before 
merging data together, it should be checked for consistency using the Edge snapping tools.
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Merging in ArcToolBox

• Use Append (9.0)
– Create empty feature class first
– Output fields must be same as input

• Use Merge (9.1)
– New feature class created

Merging in ArcToolBox
In ArcToolBox use the Append tool (at ArcGIS 9.0) or Merge tool (at ArcGIS 9.1) to 
combine layers of data together. If you use the Append tool you must create a new empty 
feature class yourself (you can do this in either ArcCatalog or ArcToolBox). If you use 
Append make sure the new feature class you create has the same fields as the input 
feature classes. If you use Merge then a new feature class is created for you. Note: When 
creating a new personal GDB feature class you can import fields (the schema) of another 
feature class, meaning you do not have to add fields yourself. In ArcGIS 9.1 the Merge tool 
performs the same task, without you having to create a new empty feature class first. 
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Edits and corrections

• Corrections and revisions to map data
• Corrections and revisions to attribute information

ReshapeReshape

Edits and corrections
Once boundaries have been finalized the cadastral data will be revised and checked 
following agreed quality control procedures. Boundaries may be re-shaped or modified, 
tasks that can be achieved using ArcGIS topology tools. Attributes may be edited to correct 
any mistakes. All of these actions require that you are editing the source data.
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Modifying features

• Use the Modify Feature task
– Short-cut double click on a feature

• Edit vertices
– Use context menu or sketch properties tool

Edit sketch vertices 
to modify a feature

Edit sketch vertices 
to modify a feature

Sketch PropertiesSketch Properties

Modifying features
To modify a feature, select it using the Edit tool and set the Task to Modify Feature. 
Alternatively double click on the feature to edit its sketch. To edit vertices use the Sketch 
context menu or the Sketch Properties tool.
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Modifying attributes

• Correct record values
– Use Attributes tool in an edit session
– Use Field Calculator in/outside an edit session

Attributes toolAttributes tool

Field CalculatorField Calculator

Modifying attributes
You can edit attributes using the Attributes tool and field calculator in an edit session, or the 
Field Calculator outside an edit session. The advantage of using the field calculator is that 
you can globally update record values, the only disadvantage is that you cannot undo your 
changes as you in an edit session by pressing the CTRL + Z keys on the keyboard.
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Maintaining relationships

• Topology models relationships
– Adjacency and coincidence

• Use Topology tools to maintain relationships

Maintaining relationships
Topology is described as the mathematics of relationships which are created when 
capturing data – for example the Auto-Complete Polygon task ensures adjacency and 
setting the snapping environment ensures connectivity. During an edit session use the 
Topology Toolbar in ArcMap to maintain relationships between features i.e. adjacency 
between polygons and connectivity between lines. For example you may want to edit a 
shared boundary between parcels, rather than editing each boundary separately you can 
edit them as if they were the same feature. Similarly if you want to move roads at an 
intersection it would be easier to move the intersection point and have the roads move as 
one as well rather than moving each road separately.
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Editing topology

• Create Map Topology
• Use Topology Edit tool
• Set Topology task
• Perform edits

Common boundary 
changed

Common boundary 
changed

Editing topology
To perform edits to topology first start an edit session. From the Topology toolbar, click the 
Map Topology tool and specify which layers will be spatial coincident (determined by the 
Cluster Tolerance in meters) when making topological edits. Next click the Topology Edit 
tool to select a common boundary (for polygons). The common boundary will be highlighted 
in magenta. Set a topology task from the Task drop-down list in the Editor toolbar. Next use 
a sketch tool to draw a new boundary or edit the vertices along that boundary. Once 
complete press the F2 key on the keyboard and you will see boundaries of adjacent 
polygons have both been changed.
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Linking Mutation forms

• Establish a link between properties and scanned 
mutation forms

Mutation form 
displayed

Mutation form 
displayed

Click on parcelClick on parcel

Linking Mutation forms
Linking mutation forms by means of hyperlinks allows you to establish a connection 
between parcels and scanned documents. Using the Hyperlink tool in ArcMap you can click 
on a parcel/building and review its associated mutation form. 
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Creating hyperlinks

• Dynamically - using the Identify tool

• Permanently - using field in a layer’s attribute table

Layer propertiesLayer properties

Identify toolIdentify tool

Creating hyperlinks
Hyperlinks can be set in one of two ways (i) dynamically - using the Identify tool. Click on a 
feature using the Identify tool, then choose to Add a Hyperlink… by right clicking on the 
value in the left hand side of the Identify Results window. Simply browse for the mutation 
form to associate and then use the Hyperlink tool to view the document in ArcMap. 
Hyperlinks created in this way are saved with the map, so if you want someone to see the 
hyperlinks you have set you must share you map document; (ii) Permanently - by adding a 
text field to the layer’s attribute table and typing in a record value that matches the name 
and directory path of the mutation form you want to associate with the feature. Under the 
Display tab in the Layer Properties dialog box you can specify that hyperlinks are supported 
by the field you have just added, then use the Hyperlink tool to view the document in 
ArcMap. If you save the layer file to disk then the hyperlink properties are saved too and do 
not have to be reset.
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Joining property details

• Join property details to parcels/buildings

Join based on 
Mutation Form 

Number

Join based on 
Mutation Form 

Number

Joining property details
Use the Join and Relate commands to link details held in MS Access to parcels and 
buildings. In section 3 you saw how to create a database called Mutation Forms with two 
tables called Property Object and Subsequent Transactions. Each table contained the field 
Mutation_form_number, you can use this field to link the tables to parcels and buildings 
which also have a mutation form number field. In ArcMap when performing a Join or Relate 
field names do not have to be the same, but the data types of the fields must be. 
Join
Use Join for 1:1 or M:1 cardinality. Join appends fields from one table to another. You will 
join the Property Object table to the Parcel or Building layer as one parcel/building has a 
single address and one initial transaction. To create a Join, right click on Parcel/Building 
layer and choose Joins and Relates > Join…. In the Join Data dialog box select the 
common field in the Parcel/Building layer (e.g. Mutation form number) the Property Object 
table and the common field (e.g. Mutation form number).
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Relating subsequent transactions

• Relate subsequent transactions to parcels/buildings

Relates in Identify 
Window

Relates in Identify 
Window

Relates in Table 
Window

Relates in Table 
Window

Relating subsequent transactions
Use the Relate for 1:M or M:M cardinality. Relate establishes a relationship between one 
table and another, but they remain physically separate. You will relate the Subsequent 
Transactions table to the Parcel or Building layer as one parcel/building can have many 
transactions associated with it. To establish a relate right click on the Parcel/Building layer 
and choose Joins and Relates > Relate from the context menu. Select the common field in 
the Parcel/Building layer (e.g. Mutation form number), the Subsequent Transactions table 
and the common field in the table (e.g. Mutation form number), optional name the relate. To 
view related tables for the Parcel/Building layer, select a parcel/building, open the layer’s 
attribute table and click the Options button and choose Related Tables from the pop-up 
menu. Alternatively use the Identify tool, when you click on a feature the related table will 
appear in the Identify results window.
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The cartographic process

• Preparing the cadastral index map
– All properties outlines in solid lines
– All street and major buildings named
– Symbols follow ESA standards

MUSSADDAQ STREET
E

D
O
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A

Named buildings, 
street lamps and 

control points

Named buildings, 
street lamps and 

control points

The cartographic process
The cartographic process involves symbolising features on the map using predefined colors
and patterns and the use of text to annotate major properties and all streets. There are ESA 
guidelines that determine symbology and text to be used. The next slides describe how to 
create a map using ArcMap.
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Symbolizing features

• Select a predefined symbol
– For polygons set outline and fill
– For lines a line style
– For points a marker symbol

Setting a polygon 
fill and outline

Setting a polygon 
fill and outline

Symbolizing features
Use the Layer properties dialog box to set polygon, line and marker symbols. Right click on 
the layer and choose Properties… from the context menu, click the Symbology tab and click 
on the current symbol to set an alternative, selecting it from the Symbol Selector dialog box.
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Creating your own symbols

• Use the Style Manager
• Select symbol type

– Simple
– Character
– Picture

• Save symbols to file

Creating a character 
marker symbol

Creating a character 
marker symbol

Creating your own symbols
You can create you own symbols using the Style Manager, when you create symbols in this 
way you are either saving them to an existing Style file or you can save them to a new Style 
file. Style files can be shared amongst users so if you create symbols that you want to 
share with another person simply make the style file available to them (e.g. by placing it on 
a network drive)
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Labels and Annotation

• Labels are scale independent and dynamic
• Annotation is scale dependent and static

StaticDynamic

Saved with map or in 
geodatabase

Property of the layer

Scale dependentScale independent

ANNOTATIONLABELS

Labels and Annotation
Labels are a property of a layer, they are scale independent and dynamic, so a map at 
scale 1:5,000 would have different labels, of the same font size, at a scale of 1:10,000. This 
may be problematic when producing maps since text should remain in the same place on 
the map irrespective of its scale. This is what annotation allows you to do. By setting a 
reference scale in effect you are saying at 1:5,000 text on the map should appear as 12 
point Arial font, when you zoom in it gets bigger, when you zoom out it gets smaller, but the 
text remains static in terms of geography. Generally the process of creating annotation is as 
follows: label features, set an appropriate reference scale and then convert labels to 
annotation.
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Creating labels

• Use Layer Properties or Label Manager
• Choose label field
• Set placement properties
• Set font, size and style

Polygon label 
placement properties

Polygon label 
placement properties

Creating labels
To label features in a layer either use the Layer Properties dialog box or the Label Manager 
toolbar. Select a label field and set the placement options. For points labels can be placed 
using predefined placement positions, on the point, or at an angle (which you can specify or 
can be set by using the values of a numeric field in the attribute table). For lines labels can 
be placed above or below the line, at right angles, horizontal or along the direction of the 
line. For polygons labels can be placed horizontally or along the longest edge of the 
polygon feature. You can also set ranks and priorities specifying whether labels are more 
important than features. Finally set a font, size and style for the labels. To label features 
right click on the Layer in the table of contents and choose Label Features from the context 
menu.
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Creating annotation

• Convert labels to annotation
• Storage options

– Map document
– Geodatabase

• Editing options
– Annotation toolbar (GDB)
– Drawing toolbar (MXD)

Converting labels 
to annotation

Converting labels 
to annotation

Creating annotation
To create annotation first choose to create labels, then convert the labels to annotation by 
right clicking on the layer and choosing Convert Labels to Annotation from the context 
menu. You can choose to save Annotation to the map document or a geodatabase
(shapefiles do not support annotation). The preference is to save annotation to a 
geodatabase since annotation behaves like another feature class and can be added to any 
map document. If you save annotation to a map document you must share the MXD (map 
document) with another person. 
Editing annotation
Depending on where annotation is saved determines how it is edited. Annotation in a map 
document can edited using the Drawing toolbar, annotation in a geodatabase using the 
Annotation toolbar – you must be editing the geodatabase to use the Annotation toolbar.

The Drawing toolbarThe Drawing toolbar
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Using layer files

• Layer files store symbology and 
labelling
– Ensures standardized symbology for 

features

• Import symbology from a layer file

Importing symbology 
from a layer file

Importing symbology 
from a layer file

Using layer files
When you save a layer file (*.lyr) to disk you are saving the properties set for a layer. To 
save a layer file right click on a layer and choose Save as Layer file from the context menu. 
Layer files behave like any other source data in ArcMap, click on the Add Data tool and 
navigate to where a layer file has been saved, when added to the map document you will 
see the symbology and labelling properties set for the layer when it was saved. You can 
import symbology from a layer assigning symbology to a layer added to your map 
document. You can also change the source data too, right click on the layer and choose 
Properties… from the context menu, under the Source tab click the Set Data Source button 
and navigate to a different data source, the symbology remains the same but the features 
change. Using layer files makes your job of symbolizing features very easy.
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Creating the cadastral index map

• Design in the Layout View

• Set page properties
• Add cartographic elements

– North arrow, etc

• Print or export

A cadastral index 
map

A cadastral index 
map

Creating the cadastral index map
Design the cadastral index map in the layout view. To switch to the Layout View choose 
Layout View from the View menu. The layout view presents a virtual page onto which you 
add cartographic elements, you can create any size map from A4 to A0, and select a 
portrait or landscape orientation. You can create maps of fixed scale using the Scale 
notation in the Standard toolbar.
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Setting page properties

• Can design map up to any size
• Uncheck ‘Use Printer Paper Settings’
• Set page size and orientation 

Setting page size 
irrespective of printer 

limitations

Setting page size 
irrespective of printer 

limitations

Setting page properties
To set page options choose Print and Page Setup from the File menu. You can design any 
size map if you uncheck the option ‘Use Printer Paper Settings’ in the Print and Page Setup 
dialog box as shown above. If you select the option ‘Scale Map Elements proportionally to 
changes in Page Size’ elements on the map will be scaled when you change the page size 
from A4 to A0.
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Adding cartographic elements

• Use Insert menu to add:
– North Arrow, Legend, Scale Bar, Picture, Title
– All elements are dynamic

• Set properties for each element

Selecting a North ArrowSelecting a North ArrowSetting Legend propertiesSetting Legend properties

Adding cartographic elements
To add a cartographic element use the Insert menu, make sure you are in the Layout View 
otherwise this option will be greyed out. When adding a cartographic element you will work 
with either a wizard or template selection dialog box. Any element added to the layout is 
dynamic – any changes the element’s source object will be reflected in the layout view. You 
can add north arrows, scale bars, text, pictures and objects (e.g. an MS Excel 
Spreadsheet). You can also add text from the Drawing toolbar using any one of the text 
tools:

Text tools in Drawing 
toolbar

Text tools in Drawing 
toolbar
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Modifying cartographic elements

• Changing properties
– Double click on an element; or
– Right click and choose Properties…

• Move
• Delete
• Copy

Modifying a north arrowModifying a north arrow

Modifying cartographic elements
To modify a cartographic element, double click on the element using the Select Elements 
tool in the Drawing or Tools toolbars, or right click on the element and choose Properties…
from the context menu. Change the properties accordingly. To move an element simply 
drag and drop, to delete an element select it and press the Delete key on the keyboard. 
You can also copy and paste elements in the layout view.
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Using templates

• Predefined map layouts
– Fixed placement of cartographic elements

• Select template to use after adding data to map document

Changing the layoutChanging the layout

Using templates
Templates allow you to give a standardized look and feel to you maps. Templates are 
stored as MXT files and are created in ArcMap. In the Layout View design an empty map 
(i.e. a map that doesn’t contain any geographic data), adding frames, legends, north arrows 
etc. and save the map document to disk not as a MXD but as a MXT file. To use the 
template create map document switch to the Layout View and click the Change Layout tool 
in the Layout toolbar and select the MXT file saved to disk.



Preparing the cadastral index map v0.2.ppt
Module B: ESA Cadastral Operations Course
Technical Report # 6-29

Review and approval

• Final review to check:
– Symbology is correct
– Measurements are correct
– Text is correct

Review and approval
A final review of the cartographic product will ensure it meets ESA standards and can be 
approved. 25% of the map is assessed for cartographic consistency to ensure that symbols, 
measurements and text are correct.
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Printing and exporting

• Print options
– Page size, printer

• Export formats
– TIFF, JPEG, PDF

• Set export options
– Quality, resolution

Printing and exporting
When the map is ready for printing you can choose to print directly or export the map to one 
of many supported graphic file formats. If you choose to export to PDF (Portable Document 
Format) page size is maintained (this is not true of other graphic file formats) and someone 
can view your map using Adobe’s Acrobat Reader, freely downloadable from the internet.
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Exercises 9, 10, 11, 12 & 13

• Exercise 9
– Edgematching

• Exercise 10
– Merging 

• Exercise 11
– Establishing hyperlinks

• Exercise 12
– Joins and relates

• Exercise 13
– Creating a cadastral index map
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EXERCISE 1: ARCGIS REFRESHER 
 
In this exercise you will be reacquainted with ArcGIS functionality by exploring the two core 
applications ArcMap and ArcCatalog and ArcToolBox. 
 
Step 1: Start ArcCatalog and explore a shapefile 
 

 Start ArcCatalog. 
 

 In the Catalog tree (left hand pane) navigate to the C:\TRAINING\DATA\BASE DATA 
folder: 

 

 
 

 In the right hand pane of ArcCatalog notice that there are two shapefiles: River_Nile and 
Cairo_Census: 

 

 
 
The icon to the left of the shapefile name gives you a clue as to the geometry; in this case 
both shapefiles are polygons. Next examine the properties of the Cairo_Census shapefile: 
 

 Right click on the Cairo_Census shapefile and choose Properties… from the context 
menu: 

 

 
 In the Shapefile Properties dialog box click on the Fields tab. 

 
You will see a list of fields (columns) in the shapefile’s attribute table. One of these fields is 
called ‘SHAPE’: 
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 Click on the field ‘Shape’ and examining the field’s properties at the bottom of the dialog 
box answer the following questions: 

 
 What is the Spatial Reference of the shapefile? _______________________________ 

 
 What is the geometry of the shapefile? ______________________________________ 

 
 Click the Cancel button to dismiss the Shapefile Properties dialog box. 

 
 In the right hand pane of ArcCatalog, click on the Preview tab. In ArcCatalog you can 

examine data before using it, previewing (examining) either features (Geography) or 
attributes (Table): 

 

 
 Click on the Metadata tab. Metadata provides some background information about the 

dataset (if it has been completed): 
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 What is the Abstract of the shapefile? _____________________________________ 
 

 
 
We have finished with ArcCatalog, so close the application. You will now explore ArcMap. 
 
Step 2: Start ArcMap and explore a map document 
 

 Start ArcMap. 
 

 When prompted choose to Start using ArcMap with ‘An existing map’ and double-click 
‘Browse for maps…’: 

 

 

What is Metadata? 
Metadata is information about information. It is extremely useful as it 
allows users to understand what data they are dealing with – its scale, age, 
etc which help determine whether they can use the data or not. You create 
Metadata in ArcCatalog. ArcGIS supports two metadata standards FGDC 
and ISO. These standards define a minimum set of properties that must be 
described when creating geographic data. Metadata is not mandatory but 
you should complete metadata for data that you create. 
 



EFS Project Task 2 Registration 

Module B_Course Exercises v0.2.doc 
Technical Report # 

6

 Navigate to the C:\TRAINING\DATA\MAP DOCUMENTS folder and open the map 
document ‘Introduction.mxd’. 

 

 
 
When the map document opens you will see it contains 2 layers – The River Nile and Cairo 
1996 Census within a single data frame called Cairo Environs: 
 

 
 
First you will change the symbology of the Census layer: 
 

 Right click on the Cairo 1996 Census layer and choose Properties… in the context 
menu. 

 
 In the Layer Properties dialog box click on the Symbology tab: 

 

 
You will use a numeric legend to depict census data: 
 

 In the Show column click ‘Quantities’ and accept the default numeric legend type 
‘Graduated Colors’: 

 

 

What is a Map Document? 
A map document organizes your work. Map documents have the file 
extension MXD. Whenever you save a map document you save the current 
state of your work. Map documents contain data frames (containers for 
spatial data) and layers (references to spatial data on disk). 
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 From the Value drop-down list select the field ‘TOTAL_POPU’ field: 

 

 
 A numeric legend based on a predefined color ramp will be create automatically: 

 

 
 In the Layer properties dialog box click the OK button to apply the changes you have 

made and dismiss the dialog box. 
 
The layer will be drawn with the legend selected. 
 
 
Step 3: Show ArcToolBox window and run a tool 
 

 Click the Show/Hide ArcToolBox tool  to show the ArcToolBox window. 
 

 Navigate to Analysis Tools > Statistics 
 

 Double click on the Summary Statistics tool, this tool will create a database file that 
contains statistics for selected census information (e.g. the total population for Cairo): 
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 Complete the Summary Statistics dialog box as follows: 
 

 
 

 Click OK to create the statistics table. 
 

 Dismiss the Progress dialog box by clicking the Close button. 
 
Now add the table to the map document. 
 

 Click on the Add Data tool  
 

 Navigate to the C:\TRAINING\DATA\BASE DATA and add the table 
Cairo_Census_Statistics.dbf 

 
 Right click on the table and choose Open from the context menu: 

 

 
 Examine the table, you will see that the column headings read SUM_TOTAL_ (total 

male), SUM_TOTAL1 (total female), SUM_TOTAL2 (total population), this corresponds 
to the sequence of fields in the Summary Statistics dialog box. What you have created 
are total figures for census data. 

 
 Close the table and hide the ArcToolBox window by clicking the Show/Hide ArcToolBox 

Window. 
 

 Close ArcMap choosing not to save your changes when prompted. 
 
This exercise provided a brief overview of ArcMap, ArcCatalog and ArcToolBox. The 
subsequent exercises show you how to use ArcGIS to support out the cadastral operations 
methodology. 
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EXERCISE 2: INDEXING MUTATION FORMS 
 
In this exercise you will learn how to create a database in MS Access to hold mutation form 
details recorded on the first 3 pages of a mutation form. This information relates to the 
property, subsequent transactions and the initial transaction. You will be required to index 
(record) all mutation forms for the Mokattam area (approximately 2,600 for parcels and 1,900 
for apartments) 
 
Step 1: Start MS Access, create a database and tables 
 

 Start MS Access. 
 

 From the File menu choose New… 
 

 From the New File window click ‘Blank Database’: 
 

 
 

 Navigate to the C:\TRAINING\DATA\INDEXING folder and create a database called 
‘Mutation Forms.mdb’ 

 
You will create two tables that each shares the field ‘Mutation Form Number’. One table 
represents the building/parcel and its initial creation as a result of a transaction (e.g. a sale). 
The other table represents subsequent transactions against the building/parcel. This is 
described as a 1: M (one to many) relationship type in other words one property: many 
transactions: 
 
 
 
 
 
 
 
  
 
 
Key fields, cardinality and understanding relationships 
In a relational database management system (RDBMS) tables which store 
information are linked by use of primary key fields (i.e. fields common to both that 
contain unique values and are not null). The number of matching rows in linked tables 
is known as cardinality. For example Table A may have a single row that matches 
many rows in Table B (hence 1: M). Examples of cardinality are 1:1, M: 1, 1: M and M: 
M. The type of relationship is important as it determines what command is used in 
ArcGIS when linking tables together, more later. 
 

Mutation Form No: 
745960064 

Mutation Form No: 745960064 
Transaction A (1999) 
Transaction B (2004) 
Transaction C (2006) 
….. 
….. 
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 In the ‘Mutation forms: Database…’ window double-click ‘Create table in Design view’: 

 

 
 

 In Design View, add the following fields (Note: the Type and Size columns list the 
properties to be set for each field you add). You must use underscores between words 
as no spaces are allowed in ArcGIS: 

 

 
 

 To add a field simply type in the name as shown above, and set a data type from the 
drop down list: 
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 Next set the properties for the field at the bottom of the table properties window: 
 

 
 

 Once you have added the fields, set the Mutation_form_number field as the Primary Key 
by right clicking on the ‘Mutation_form_number’ field and choosing ‘Primary Key’ from 
the context menu: 

 

 
 

 Next save the table. From the File menu choose Save and type in ‘Property Object’ as 
the table name: 

 

 
 

 Create another table and add fields as follows (the Type and Size columns list the 
properties for each field). Notice the table also contains the field Mutation_form_number, 
but this should not be set as the Primary Key as it will not be unique i.e. there will be 
many records with the same mutation form number. Instead set the Transaction_ID field 
(an AutoNumber data type) as the Primary key: 
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 Save this table as ‘Subsequent Transactions’. 
 
To facilitate data entry you will create two forms using the two tables you have just created: 
 

 In the ‘Mutation Forms: Database….’ window click on ‘Forms’ and double-click ‘Create 
form by using wizard’: 

 

 
 

 In the first dialog box, select the Table: Property Object and choose to include all fields in 
the form by clicking the >> button: 

 

 
 Click Next > to continue. 

 
 For the Layout choose ‘Justified’: 

 

 
 Click Next > to continue. 
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 For style accept the default ‘Standard’: 
 

 
 Click Next > to continue. 

 
 Accept the default name for the form ‘Property Object’: 

 

 
 Click Finish to create the form. 

 
 Close the form and repeat the step for the ‘Table: Subsequent Transactions’ using the 

same settings for the Property Object form. 
 
You are now ready to start entering values. 
 
NOTE: Once these forms and tables have been created you do not have to repeat these 
steps; you can simply add record values by opening the required form. 
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Step 2: Add records using forms 

 Complete the ‘Property Object’ form as follows: 
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 Add two records to the ‘Subsequent Sales’ form as follows: 
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Fatma 
Kader 

Nigel 
Edmead 

Consent 
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156 2004 

56773 199 01/01/2006 Fatma 
Kader 

Ali Abd 
Salam 

Bob 
Cross 

Consent 
Sale 

201 2006 

You have now completed indexing a sample mutation form and will see in a later exercise 
how to link this information to features in ArcMap. 
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EXERCISE 3: GEOREFERENCING RASTER DATA 
 
In this exercise you will learn how to georeference an unregistered image in ArcGIS. 
 

 Start ArcMap and choose to open a new map document. 
 

 Click on the Add Data tool in the application GUI. 
 
Step 1: Load the data files 
 

 Navigate to C:\TRAINING\DATA\GEOREFERENCING and add the following files: 
parcels.shp, streets.shp and historic.tif.  

 
 If you receive a message about missing spatial information, you can ignore this message 

and continue by clicking OK. 
 

 Select the Parcels layer and clicking on the right hand button of the mouse, choose 
Zoom to Layer from the context menu: 

 

 
Notice the image does not sit beneath the parcels. Since the parcels layer does have a 
spatial reference defined you will use it to register the image. 
 

 In the Tools toolbar click on the Full Extent tool , while you can’t see anything very 
clearly the image is located in the bottom left of the display, the parcels in the top right.  

 
 Select the image layer (historic.tif) and clicking on the right hand button of the mouse, 

choose Zoom To Layer.  
 
Now you can see the image. 
 

 From the View menu choose Toolbars and select Georeferencing to enable the 
Georeferencing toolbar: 

 

 
 From the Window menu choose Overview. The overview window displays whatever 

currently appears in the map display. You may want to move the Layers Overview 
window out of the way so you can see the image clearly. 

 

Notice that placed on the image are 4 registration points, identified numerically as 601, 602, 
610 and 473. These are found at street intersections.  

 From the Edit menu choose Find… 
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 In the Find Box type ‘Peacock’. 
 

 Under ‘In Layers’ choose the Streets layer from the drop-down list. 
 

 Under Search click ‘In fields’ and choose NAME from the drop-down list: 
 

 
 Click the Find button. A single street is found. Right-clicking on the street, choose Zoom 

to feature(s). Dismiss the Find dialogue box. 
 
Since you can’t really see which street is Peacock Street you will label the layer. 
 

 Select the Streets layer and clicking on the right hand button of the mouse choose Label 
from the context menu. 

 
You can now see which street is Peacock Street. 
 

 Zoom into the area that corresponds to the 4 street intersections on the image: 
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 Turn off the Parcels layer 
 
Step 2: Georeference the image 
 
You are now ready to register the image. 

 In the Georeferencing toolbar make sure the Layer is set to Historic.tif: 
 

 
 

 Click the Georeferencing dropdown arrow and choose ‘Fit to display’. 
 
ArcMap scales the image to fit the current window. You will notice that even though the 
image has been scaled the registration points do correspond exactly with the street 
intersections in the streets layer. 
 

 Close the Overview window and from the Window menu choose Magnifier. 
 

 Move the Magnification window over registration point 602, you will see the street 
intersection and registration point are offset: 

 

 
 From the Georeferencing toolbar click the Add Control Points tool: 

 

 
 In the Magnification window, centre the Add Control Points tool’s cursor over the 

registration point on the image and then click and drag a link to the street intersection in 
the streets layer. The link will be shown by a green line. Remember click on the image 
registration point first, then the street intersection. 

 
You will notice that the image is scaled.  
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 You can examine the control point you have just added. From the Georeferencing 
toolbar click the View Link Table tool: 

 

 
 
The Link Table window shows the image coordinates and corresponding map coordinates: 
 

 
 Now continue with the other three registration points in the same manner described 

above. Note you will have to move the Magnification window over each registration point 
in turn and tie it to the appropriate intersection. Each time you do this the image will be 
scaled. 

 
When you have completed the 3 other points you are now ready to register the image.  
 

 From the Georeferencing drop-down menu choose Update Georeferencing to save the 
new registration. An AUX file is written to the directory where the image file is stored 
which now contains spatial reference information. 

You don’t need the control points anymore. 

 From the Georeferencing drop-down menu choose Delete Control Points. 
 

 Since you have finished save the map document in your C:\TEMP directory as 
ExGeoferencing.mxd.  
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EXERCISE 4: SPATIAL ADJUSTMENT 
 
In this exercise you will learn how to convert CAD data into an editable ArcGIS format and 
adjust the data from local coordinates to coordinates of the Egyptian Transverse Mercator 
(ETM) projection.  
 

 Start ArcMap and choose to open a new map document. 
 
Step 1: Load a CAD feature dataset 

 Click on the Add Data tool in the application GUI  
  

 Navigate to C:\TRAINING\DATA\CAD directory and add the ‘Polygon’ Feature Class 
from the CAD feature dataset Survey.DWG: 

 

  
 

 You will get a warning message that the layer lacks a spatial reference, do not worry at 
this point and click OK to continue: 

 

 
The CAD polygon feature class will be added to the map document. 

 

CAD Feature Dataset vs. 
CAD Drawing File, 
what’s the difference? A 
CAD Feature Dataset 
represents entities 
converted to ArcGIS 
feature classes. A CAD 
Drawing is equivalent to 
an image; it cannot be 
symbolized, queried or 
exported. 
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You are looking at parcel outlines generated in AutoCAD. As you move the cursor over the 
map you will notice the coordinates do not reflect the coordinates of the Egyptian national 
grid (and may be reported as decimal degrees). This is because the data has been captured 
using local coordinate system: 

 

 
 

 
 

You will correct the coordinate problem by applying a transformation but because you need 
to be editing the source data to do this and you cannot edit CAD directly data within ArcGIS 
you will first convert the CAD file to a shapefile. 

 

Step 2: Convert the CAD layer to a Shapefile 
 

 Right click on the Survey.dwg Polygon layer in the table of contents and choose Data > 
Export Data… from the context menu: 
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 In the Export Data dialog box, accept the default setting for ‘Use the same coordinate 
system as: this layer’s source data’. 

 
 For the ‘Output shapefile or feature class’ create a new shapefile called ‘Mokattam.shp’ 

in the C:\TRAINING\DATA\CAD folder, you can either use the browse button or type in 
the directory path yourself: 

 

 
 Click OK to continue. 

 After the conversion process is complete and when prompted, choose to add the 
shapefile to the map document: 

 

 
 Since you no longer need to the drawing file, right click on the Survey Polygon.DWG 

layer and choose Remove from the context menu: 
 

 
You have successfully converted the CAD file to a shapefile; you could have done this in 
ArcToolBox and ArcCatalog as well. This data can now be edited which means in can be 
adjusted. 
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Step 2: Perform spatial adjustment 
 
You can correct the coordinate information of vector data in ArcMap by applying a 
transformation, but this has to be done within an edit session. 

 

 Click the Editor Toolbar tool  to enable the Editor Toolbar (if not visible already). 
 

 From the Editor drop-down menu in the Editor toolbar choose Start Editing: 
 

 
 If displayed ignore the warning message relating to different coordinate systems, clicking 

Start Editing to continue. 
 

 From the Editor tool bar choose More Editing Tools > Spatial Adjustment to enable the 
Spatial Adjustment toolbar (if it is not visible already): 

 

 
 

 From the Spatial Adjustment drop-down menu choose Set Adjust Data…: 
 

 

What’s a transformation? 
A geometric transformation that scales rotates, skews, and/or translates images 
or coordinates between any two Euclidean spaces. It is commonly used in GIS to 
transform maps between coordinate systems for example between a local CAD 
coordinate system and a real world coordinate system such as the Egyptian 
Transverse Mercator: 
 

   0, 0 40000, 30000 
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 In the Choose Input for Adjustment dialog box check on the option ‘All Features in these 
layers’ for Mokattam.shp. Click OK to dismiss the dialog box: 

 

 
 From the Spatial Adjustment drop-down menu choose Links > Open Links File…: 

 

 
 

 Browse to the directory C:\TRAINING\DATA\CAD and open the file 
‘Mokattam_Transformation.txt’. This contains a set of source and destination 
coordinates, allowing you to transform the data from local coordinates of the CAD 
drawing to the coordinates of the Egyptian Transverse Mercator.  

 

 
 

 From the Spatial Adjustment drop-down menu choose Links > View Links Table... to 
view these coordinates and the residual errors for each point and an average for all 4 
points: 

 

How can you add displacement links? 
There are three ways of adding displacement links, i.e. source and destination 
coordinates: (i) Manually, you locate both source and destination points 
interactively (ii) Using a Control Points file which contains destination 
coordinates these are known locations, you add the source coordinates 
interactively (iii) Using a Links File in which both source and destination 
coordinates are known. This method is shown in this exercise 
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 Question: What is the overall RMS? _____________ meters (the coordinates of the ETM 
coordinate system) 

 

 

What does RMS mean and what’s an acceptable value? 
RMS stands for Root Mean Square. It is a measure of the difference between 
locations that are known and locations that have been interpolated or 
digitized. RMS error is derived by squaring the differences between known 
and unknown points, adding those together, dividing that by the number of 
test points, and then taking the square root of that result. (Source: GIS 
Dictionary, ESRI). For the purposes of the project an acceptable RMS = 
(source scale * 0.02) e.g.: 
 
Scale  RMS (in meters)1, 2 

1:1,000  0.2 – 0.4 
1:10,000 2 - 4 
1:50,000 10 - 15 
1:100,000 20 - 50 
 
Notes: 
1: The RMS will always be in metres as these are the units of the Egyptian 
Transverse Mercator coordinate system 
2: The higher RMS figure is for less accurate data (e.g. CAD drawings 
acquired from New Communities of unknown history) for which low RMS 
readings may be impossible to attain 
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 From the Spatial Adjustment drop-down menu choose Adjust: 
 

 
Immediately the features will be shifted to a different location and will no longer be visible in 
the display. 

 Before zooming the layer’s new location, choose Stop Editing from the Editor drop-down 
menu. Save your edits when prompted. 

 Right click on the ‘Mokattam’ layer and choose Zoom to Layer from the context menu. 

While the coordinate values are now correct (i.e. in meters), they may still appear to be 
reported as decimal degrees, to correct this problem change the units of the data frame. 

 Right-click on the Layers data frame in the table of contents and choose Properties… 
from the context menu. 

 
 Under the General tab, change the Map and Display Units to ‘Meters’: 

 

 
 Click OK to apply the changes and dismiss the dialog box. The readings in the status bar 

will now be correct. 
 

 Since you have finished save the map document in your C:\TEMP directory as 
ExAdjustment.mxd.  
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EXERCISE 5: RUBBERSHEETING 
 
In this exercise you will learn how perform rubbersheeting using the Spatial Adjustment 
toolbar in ArcMap. 
 

 Start ArcMap. 
 
Step 1: Open a map document and examine problem areas 
 

 First open an existing map document. Navigate to C:\TRAINING\DATA\MAP 
DOCUMENTS and open the map document Rubbersheeting.mxd.  

 

 
 
In this exercise you will use a control points file to perform the adjustment. A control points 
file has been saved for you. This lists destination coordinates (these are taken from the Total 
Station data). You will have to identify the source coordinates in the GPS layer and add 
displacement links interactively so as to adjust the GPS layer to the more accurate Total 
Station layer. 
 
First use a saved bookmark to examine a problem area. 
 

 From the View menu choose Bookmarks > Error 1, you will see that neither boundary 
aligns correctly: 

 

Mis-matching features and rubbersheeting 
This map document shows some of the common problems you will encounter when 
combining data together (be it old and new data or data collected using different 
collection methods). In this example a block boundary has been surveyed using GPS and 
Total Station. You will notice there is clearly a discrepancy between the two 
boundaries. A decision has to be made as to which one is more accurate. Generally the 
answer would be Total Station. In this exercise you will move the features in the GPS 
layer to the features in the Total Station layer by means of rubbersheeting.  
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Step 2: Load a control points file 
 
To perform rubbersheeting you must be editing: 
 

 Enable the Editor toolbar (if it is not already visible). 
 

 From the Editor menu choose Start Editing. 

 From the Editor menu choose More Editing Tools > Spatial Adjustment to enable the 
Spatial Adjustment toolbar (if it is not visible already). 

 From the Spatial Adjustment menu choose Links > Open Control Points File….: 

 

 Navigate to the folder C:\TRAINING\DATA\RUBBERSHEETING and open the text file 
Block Coordinates.txt 

 The file will open in a window in the map document: 

 

This file list the destination coordinates for the displacement links you are about to add 
interactively. These coordinates are taken from the more accurate Total Station Layer. 
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Displacement links adhere to the current snapping environment, so before proceeding set 
the snap environment so that displacement links snap to the GPS layer: 

 From the Editor menu choose Snapping… 

 Check on the layer snapping option Block by GPS > Vertex 
 

 
 Close the Snapping Environment window 

 
To see when you have snapped to the correct location in the GPS layer turn on Snap tips: 
 

 From the Editor menu choose Options… 
 

 Check on the option ‘Show snap tips’: 
 

 
 
You are now ready to add displacement links. 
 
Step 3: Add displacement links 
 
To add displacement links right click on a coordinate in the Control Points Window and 
choose Add Link then place a source coordinate interactively. You will place a source 
coordinate on the GPS layer. 
 

 Right click on the control point ID 1 and choose Add Link from the context menu: 
 

 
 

 You will see a displacement link appear in the display which points to the Total Station 
layer i.e. this is where a source coordinate will move to. 
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 Move the cursor away from the Total Station layer towards to the GPS layer until the 
snap tip reports ‘Block by GPS: Vertex’: 

 

 
 

 Click the left hand button of the mouse to place the displacement link. 
 

 Repeat the step for the control point ‘ID 2’ as shown below: 
 

 
 
Now you have added the displacement links you can perform rubbersheeting. 
 
Step 4: Perform rubbersheeting 
 
First set the spatial adjustment options: 
 

 From the Spatial Adjustment menu choose Set Adjust Data… 
 

 Check the option All features in these layers > Block by GPS: 
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 From the Spatial Adjustment menu choose Adjustment Methods > Rubbersheet: 
 

 
 
Now perform the adjustment. 
 

 From the Spatial Adjustment menu choose Adjust. The GPS layer will align partially to 
the Total Station layer: 

 

 
 
Since the alignment is partial, some more editing is required. 
 
Step 5: Reshape the GPS Layer 
 
You will use the Reshape task to alter the GPS layer so that the boundary matches the Total 
Station layer. 
 

 From the Editor menu choose Snapping…  
 

 Check on the option Block by Total Station > Edge: 
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 Use the Edit tool in the Editor toolbar to select the GPS layer feature that is still not 
aligned with the Total Station layer: 

 

 
 

 In the Editor toolbar set the Task to ‘Reshape Feature’ and ensure the Layer is set to 
‘Block by GPS’: 

 

 
 

 Click on the Sketch tool and move over Identity link 1 as shown below, click once to start 
drawing a reshape line: 

 

 
 

 Follow along the Total Station layer edge (you will snap to it) and when you reach the  
Identity link 2 as shown below, double click to finish: 
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The GPS boundary will be reshaped and now match the Total Station boundary: 
 

 
 
You have successfully adjusted the boundary of the GPS layer to match the Total Station 
layer. 
 

 From the Editor menu choose Stop Editing, when prompted choose to save your edits. 
 

 Close ArcMap choosing to save your changes when prompted. 
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EXERCISE 6: CREATING PARCELS FROM CAD POLYLINES 
 
In this exercise you will trace CAD polylines to create shapefile polygons. You will use the 
tools described here to process both existing CAD data as well as new data created from 
field surveying. 
 

 Start ArcMap and choose to open a new map document. 
 

 Click on the Add Data tool in the application GUI. 
 
Step 1: Load CAD entities and create a new shapefile 
 

 Navigate to C:\TRAINING\DATA\CAD directory and open the CAD feature dataset s000-
d00.dwg: 

 

 
 Using the SHIFT key select the ‘Polyline’ and ‘Annotation’ feature classes and click Add: 
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 Zoom into the lower right hand corner of the CAD drawing: 
 

 
Here you’ll find a number of parcels that will be digitized using the Trace tool. However, 
before digitizing turn off some of the annotation as the Arabic text is not being displayed 
correctly. 
 

 Right click on the s000-d00.dwg Annotation layer and choose Properties… from the 
context menu. 

 
 Click in the ‘Drawing Layers’ tab and turn off all layers except ‘no’, which is the parcel 

identifier layer and click the OK button in the Layer Properties dialog box: 
 

 
 Enable the ArcToolBox window by clicking the Show/Hide ArcToolBox tool  (if it is not 

enabled already). 
 



EFS Project Task 2 Registration 

Module B_Course Exercises v0.2.doc 
Technical Report # 

36

 Navigate to Data Management > Feature Class toolset: 
 

 
 

 Double click on the Create Feature Class tool and complete the Create Feature dialog 
box as follows: 
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 Click OK to create the new feature class and click the Close button to dismiss the 
Progress dialog box. 

 
Next add a parcel identifier field: 
 

 Right click on the Parcels layer in the map document’s table of contents and choose 
‘Open Attribute Table’ from the context menu. 

 
 With the attribute table open click on the Options  button and choose ‘Add Field…’ 

from the pop-up menu. 
 

 Now add three (3) fields: REN (Type: Long Integer, Precision: 20), Parcel_No (Type: 
Long Integer, Precision: 20) and Mut_Frm_No (Type: Long Integer, Precision: 20): 

 

 
 Close the attribute table once the field has been added. 

 
Step 2: Trace CAD polylines 
 
You are now ready to begin tracing polylines to create parcels. 
 

 In the application GUI click on the Editor toolbar tool  to enable the Editor toolbar (if 
it is not enabled already). 

 
 From the Editor drop-down menu choose Start Editing. 

 
 Ignore the warning about editing in a different coordinate system by clicking the Start 

Editing button. 
 

 From Editor drop-down menu choose Options… 
 

 Under the General tab set the ‘Snap tolerance’ to ‘3’ ‘map units’: 
 

Add three fields: REN, 
Parcel_No and Mut_Frm_No 
all have the same field 
properties. If you make a 
mistake defining a field, 
delete the field and start 
again. 
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 Click the OK button to set the snap tolerance and dismiss the dialog box. 

 
 From the Editor drop-down menu choose Snapping. 

 
 In the Snapping Environment window check on the options shown below: 

 

 
 

 Close the Snapping Environment window. 
 

 In the Editor toolbar click the Edit tool  
 

 Using the Shift key select the 4 edges of parcel 37: 
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 In the Editor toolbar click the drop-down next to the Sketch tool and select the Trace tool: 
 

 
 Accept the default values for the Task and Target layers: 
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 With the trace tool selected click on the lower left corner of parcel 37. 
 

 Then move easterly along the edge of boundary 1, move up boundary 2, along boundary 
3 and down boundary 4, tracing the selected lines.  

 
You will see a thin black line move along the selected lines which represents the trace line; 
do not worry if it appears to go haywire: 
 

 
 

 When you have returned to the start point double-click the left hand button of the mouse 
to create a new parcel: 

 

 



EFS Project Task 2 Registration 

Module B_Course Exercises v0.2.doc 
Technical Report # 

41

Next assign a parcel identifier to the feature. 
 

 In the Editor toolbar click on the Attributes tool . 
 

 In the Attributes dialog box type in ‘37’ as the Parcel_No: 
 

 
 

 Press the Enter key on the keyboard to update the parcel’s identifier. 
 

 Close the Attributes dialog box. 
 
Step 3: Digitize an adjacent polygon 
 
Now that you have digitized parcel 37, you will now digitize parcel 38 using the Auto-
Complete polygon task: 
 

 Select all the boundaries of parcel 38 identified below using the Select tool  in the 
Editor toolbar except is shared boundary with parcel 37: 

 

 
 

 In the Editor toolbar set the Task to Auto-Complete Polygon. 
 

 From the Sketch tools drop-down list select the Trace tool. 
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 Trace the boundary lines of parcel 38 as shown in the graphic below: 
 

 
 

 When you have reached the boundary of parcel 37 double click the left hand button of 
the mouse. 

 
 Using the Attributes tool assign a parcel number of 38 to the new polygon. 

 
Step 3: Calculate area and perimeter values 
 
Finally add an area and perimeter field to the parcels’ attribute table and use VBA code to 
calculate the geometry figures. 
 

 From the Editor drop-down menu choose ‘Stop Editing’. When prompted choose to save 
your edits. 

 
 Right click on the Parcels layer in the map document’s table of contents and choose 

Open Attribute table. 
 

 In the Attribute table window click the Options  button and choose Add Field… from 
the pop-up menu. 

 
 Add an Area field as follows: 

 

 
 Repeat the process adding a field called Length with the same properties. 
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You are now ready to update geometry values. 
 

 Right click on the Area field just added and choose ‘Calculate Values’ from the context 
menu: 

 

 
 

 Ignore the warning about being outside an edit session by clicking Yes. 
 

 In the Field Calculator dialog box check the ‘Advanced’ option. 
 

 Click the Help button and scroll down through the help until you find ‘How to use Visual 
Basic code to calculate fields based on area, length, perimeter, etc.’ 

 
 Copy the code beneath ‘To calculate area:’: 

 
Dim Output as double 
Dim pArea as Iarea 
Set pArea = [shape] 
Output = pArea.area 
 

 Paste the code into the Field Calculator as shown below: 
 

 
 Beneath ‘Area =’ type output and click the OK button: 

 

 
The area figure will be updated. 
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CHALLENGE STEP 
 
Now that you have added an Area field, repeat the step adding a Perimeter field and then 
calculate the perimeter values. Can you do this? If in doubt please ask you instructor, 
meantime here are a few helpful tips: 
 

1. Add field called ‘Perimeter’ the attribute table, defining its properties 
2. Use the Field Calculator to update the perimeter values using VBA code – do you 

remember where to find this code? 
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EXERCISE 7: HEADS UP DIGITIZING 
 
In this exercise you will learn how to perform heads-up digitizing to capture vector data from 
IKONOS imagery. The same principles described here can be applied to scanned images, 
plans or maps. 
 

 
 

 Start ArcMap. 
 
Step 1: Open a map document and create a new feature class 
 

 From the File menu choose Open and navigate to the C:\TRAINING\DATA\MAP 
DOCUMENTS folder and open the map document ‘Heads Up Digitizing.mxd’: 

 

 
 
The map document contains a subset of IKONOS data for south east Cairo. Using the 
imagery you will capture (digitize) the extents (outlines) of the two industrial parcels in the 
centre of the display. 
 

 Open ArcCatalog by clicking the ArcCatalog tool  
 

 In the Catalog tree navigate to the C:\TEMP folder 
 

What is Heads up digitizing? 
Heads up digitizing is described as ‘Manual digitization by tracing a mouse over 
features displayed on a computer monitor, used as a method of vectorizing 
raster data’ (Source: GIS Glossary, ESRI)  

You will digitize these 
two factory/warehouse 
outlines, not the 
buildings themselves 
as these are industrial 
sites but the skills 
introduced here can be 
applied to building and 
parcel outlines. 
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 Right click on the folder and choose New > Shapefile… from the context menu: 
 

 
 

 Complete the New Shapefile dialog box as follows: 
 

 
 Click OK to create the new shapefile.  

 
 Close ArcCatalog. 
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Step 2: Add the shapefile to ArcMap and add a parcel identifier field 
 
Now that you have created a new empty feature class you need to add a parcel identifier 
field, first add the shapefile to the map document: 
 

 Click the Add Data tool in the application GUI. 
 

 Navigate to the C:\TEMP folder and add the shapefile ‘Industrial_Parcels’ 
 

 Enable the ArcToolBox window by clicking the Show/Hide ArcToolBox tool  (if it is not 
enabled already). 

 
 In ArcToolBox navigate to the Data Management > Fields toolset and double click on the 

Add Field tool: 
 

 
 

 Complete the Add Field dialog as shown: 
 

 
 

 Click OK to continue. 

Field Name: type in 
PARCEL_NO for the new field 
name 

Field Type: accept the default 
setting LONG – this means 
long integer, in other words a 
whole number (no digits after 
the decimal place).  
 
The Field Precision (optional) 
should be set to 20. 
 
Leave all other fields as they 
are.
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 Close the Progress dialog box by clicking the Close button. 

 
Step 3: Digitize two parcel outlines 
 

 Click the Editor Toolbar tool  in the Standard toolbar to enable to Editor toolbar 
(ignore this step if the toolbar is already enabled). 

 
 From the Editor drop-down menu choose Start Editing. 

 
 Ignore the warning about editing in a different coordinate system by clicking the Start 

Editing button: 
 

  
 

 In the Editor toolbar ensure the Task is set to ‘Create New Feature’ and the Layer is set 
to ‘Industrial_Parcels’: 

 

 
 Click on the Sketch tool  

 
To help you digitize you will open the Magnifier window; this enlarges areas of the display 
without the need for zooming in. All editing functionality works within the Magnifier window. 
 

 From the Window menu choose Magnifier. 
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 Move the Magnifier window over the bottom left hand corner of westerly 
warehouse/factory: 

 

 
 

 Click once on the fence/wall with the left hand button of the mouse and continue clicking 
the left hand button of the mouse moving in a northerly direction to place vertices (green 
boxes) along the fence/wall. 

 
 Continue around factory/warehouse moving the Magnifier window as needed and 

clicking the left hand button of the mouse. NOTE: If you make a mistake press the CTRL 
+ Z keys on the keyboard. 

 
 When you return to the start point, double click the left hand button of the mouse. Your 

parcel should look like the one shown below, if in doubt please ask your instructor. It will 
be selected (highlighted in cyan): 

 

 
 
Now enter an identifier for the parcel: 
 

 In the Editor toolbar click on the Attributes tool   
 

You will start 
digitizing here. To 
start digitizing click 
the left hand button 
of the mouse. 
Follow the 
instructions below 
for more details. 
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 Type in a parcel ID of 557701: 
 

 
 

 Press the Enter key on the keyboard to dismiss the Attributes dialog box. 
 
Now digitize the easterly parcel. 
 

 Close the Magnifier Window. 
 

 In the Editor toolbar change the Task to ‘Auto-Complete Polygon’: 
 

 
 

 Start digitizing the easterly parcel boundary by clicking the left hand button of the mouse 
inside the parcel you have just digitized. Continue around the easterly parcel’s boundary 
finishing the boundary line by double clicking the left hand button of the mouse inside the 
parcel you have just digitized: 

 

 
 Update the attributes for the second parcel, assigning it a parcel number of 557702 

 
You have now completed the required edits. 
 

 From the Editor menu choose Stop Editing and when prompted save you edits. 

 When you have finished exit ArcMap and choose to save the map document when 
prompted. 

Make sure you start 
and finish inside the 
existing parcel 
boundary (Imagery has 
been turned off for the 
sake of clarity) 
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EXERCISE 8: CAPTURE APARTMENTS 

In this exercise you will digitize apartments and attribute these as described in the lecture 
notes. A map document containing buildings and parcels has been saved for you. First open 
an existing map document: 

 Start ArcMap and choose to open an existing map document.  
 

 Navigate to the C:\TRAINING\DATA\MAP DOCUMENTS folder and open the map 
document ‘Apartments.mxd’ 

 
This map document contains two layers buildings and parcels. The Parcels layer is labeled 
by parcel number: 
 

 
 
First you will add additional fields to the building layer. If you remember these fields (as 
described in the lecture notes) are: Real Estate Number (REN), Mutation Form Number 
(Mut_Frm_No), Building Number (Build_No), Apartment Number (Apt_No), Parcel Number 
(Parcel_No), Street Name (Str_Name), District, City and Status, with the actual field names 
in brackets because of the shapefile’s 10 character limit on field names.  
 
Use ArcToolBox to add these fields: 

 Enable the ArcToolBox window by clicking the Show/Hide ArcToolBox tool  (if it is not 
enabled already). 

 
 In ArcToolBox navigate to the Data Management > Fields toolset and double click on the 

Add Field tool. 
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 Use the Add Field tool to add the fields as shown in the table below. Note: You will have 
to add these fields one at a time: 

 
Field Name Data Type Precision 
REN Long  Integer 20 
Mut_Frm_No Long Integer 20 
Build_No Long Integer 20 
Build_Name Text 100 
Apt_No Long Integer 20 
Parcel_No Long Integer 20 
Str_Name Text 100 
District Text 100 
City Text 100 
Status Text 50 

 
Once you have added the fields you can start editing. 
 

 Click the Editor Toolbar tool  in the Standard toolbar to enable to Editor toolbar 
(ignore this step if the toolbar is already enabled). 

 
 From the Editor drop-down menu choose Start Editing. 

 
 In the Editor toolbar make sure the Task is set to ‘Create new feature’ and the Target is 

‘Buildings’: 
 

 
 Use the Edit tool  to select the Building inside Parcel Number 11. 

 

 
You will now copy and paste the building footprint 5 times as you have been informed there 
are 5 apartments at this location. 
 

 From the Target drop-down list select the Buildings layer once again to activate the 
layer. 
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 From the Edit menu choose Copy: 
 

 
 From the Edit menu now choose Paste 5 times, pasting 5 copies of the selected building. 

In other words for each apartment you are adding a polygon (which is indicative of 
ownership). Remember the polygon is not meant to represent the exact internal 
dimensions of the apartment just that there is an apartment in the building. 

 
Now select all of the apartments so that you can attribute them. To select the 5 apartments 
you have just added to the following: 
 

 From the Selection menu choose ‘Select by Location…’ 
 

 Complete the Selection by Location dialog box as shown: 
 

 
 Click the Apply button. 

 In the Editor tool bar click the Attributes tool . 
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 In the Attributes dialog box you will see that 6 features are selected, as in addition to the 

5 apartments you have just added you also selected the building footprint which 
represents the common area of the building: 

 

 
 Clicking on each building identifier in the left hand side of the Attributes dialog box, 

complete apartment details as shown in the table below (there is no building name): 
 
FID REN Mut_Frm_No Build_No Apt_No Parcel_No Str_Name District City Status 
3 0 555 22 -99 11 200 Digla Maadi Communal 
6 0 768 22 101 11 200 Digla Maadi Occupied 
7 0 898 22 102 11 200 Digla Maadi Occupied 
8 0 909 22 103 11 200 Digla Maadi Unoccupied 
9 0 1020 22 201 11 200 Digla Maadi Occupied 
10 0 2546 22 202 11 200 Digla Maadi Under 

Construction 
 

 You will notice -99 is used for the communal area, this is because it has no apartment 
number. You could have also used 0, but -99 clearly indicates that this is not an 
apartment: 

 

 
 

 Once you have added all the values choose to Stop Editing from the Editor drop-down 
menu choosing to save your edits when prompted. 

 
 Quit ArcMap choosing the save the changes to the map document when prompted. 
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EXERCISE 9: EDGEMATCHING 
 
In this exercise you will learn how perform edge matching using the Spatial Adjustment 
toolbar in ArcMap. 
 

 Start ArcMap and when prompted choose to open an existing map document. 
 
Step 1: Open a map document and start editing 
 

 Navigate to the C:\TRAINING\DATA\MAP DOCUMENTS directory and open the map 
document Edgematching.mxd 

 
The map document contains two layers: Parcel_A and Parcel_B clearly misaligned from one 
another, as you realize there shouldn’t be a gap between the parcels in the different layers. 
You have also been told that the layer Parcel_A is more accurate than Parcel B. 
 
In order to perform edge snapping you must be editing. 
 

 Enable the Editor toolbar (if it is not visible already). 
 

 Enable the Spatial Adjustment toolbar (if it is not visible already). 
 

 From the Editor drop-down menu choose Start Editing. 
 

 From the Editor drop down menu choose Options… 
 

 In the Editing Options dialog box set the Snapping Tolerance to 7 map units (meters) 
and click OK to continue: 

 

 
 From the Editor drop-down menu choose Snapping and set the snap environment to 

Vertex for both layers: 
 

 
 

 Close the Snapping Environment window. 
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Step 2: Set adjustment options and perform edge matching 
 

 From the Spatial Adjustment drop-down menu choose Set Adjust Data… and check the 
option ‘All features in these layers’ checking on Parcel_B as you know Parcel_B is less 
accurate than Parcel_A and features can move in this layer: 

 

 
 

 Click OK to dismiss the Choose Input for Adjustment dialog box. 
 

 From the Spatial Adjustment drop-down menu choose Adjustment Method > Edge 
Snapping: 

 

 
 

 From the Spatial Adjustment drop-down menu choose Options… 
 

 Under the General tab click the Options… button: 
 

 
 Set the Method to ‘Line’ and click OK to continue 
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 Click on the Edge Match tab and ensure the source is Parcel_B and the target Parcel_A, 
again this confirms features in the less accurate layer will move to those of the more 
accurate layer: 

 

 
 

 Click OK to continue. 
 

 In the Spatial Adjustment toolbar click on the Multiple Displacement Links tool  
 

 Click on the eastern edge of the top parcel in the Parcel B layer: 

 
 

 The boundary will flash. Next click on the adjacent boundary in Parcel_A, it too will flash. 
 

 When asked how many links to add accept the default number (10): 
 

 
 

 Press the Enter key on the keyboard. 
 

Click on this boundary (Parcel_B) 
with the Multiple Displacement 
Link tool, the boundary will flash, 
then click on the adjacent 
boundary in Parcel_A 
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You will see 10 displacement links added automatically: 
 

 
 
You are now ready to perform the adjustment. 
 

 From the Spatial Adjustment drop-down menu choose Adjust, the edge of Parcel_B will 
be adjusted to match Parcel_A: 

 

 
 
You will notice the edge of Parcel_B has been extended to meet Parcel_A and the parcel will 
have become bigger as a consequence. If you think this was wrong then the solution would 
be apply a transformation (see the exercise Spatial Adjustment). However, having 
successfully matched the parcels you can save your work and exit ArcMap. 
 

 Exit ArcMap choosing to save your edits and the map document when prompted. 
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EXERCISE 10: MERGING DATA 
 
In this exercise you will learn how to merge (append) data using ArcToolBox. 
 

 Start ArcMap and choose to open a new map document. 
 
Step 1: Load shapefiles to be merged 
 

 Click on the Add Data tool in the application GUI. 
 

 Navigate to the C:\TRAINING\DATA\MERGE and add the two shapefiles: sector1.shp 
and sector2.shp, representing to adjacent blocks of apartments. One block has been 
acquired from the New Communities agency and the other from field survey work. These 
two shapefiles must be merged together to create a seamless dataset, however, before 
doing that you must first create a new, empty feature class (this is a requirement in 
ArcGIS 9.0, in ArcGIS 9.1 you do not have do this): 

 

 
 

 Enable ArcToolBox, by clicking the Show/Hide ArcToolBox tool  and navigate to the 
ArcTool > Data Management Tools > Feature Class toolset and double click on the 
Create Feature Class tool: 

 

 
 

You will merge sector1.shp 
and sector2.shp into a single 
shapefile called oneblock.shp. 
You will use ArcToolBox to 
perform these tasks 
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 Complete the Create Feature Class dialog box as follows: 
 
 

 
  

 Click OK to continue. 
 

 Dismiss the Progress dialog box by clicking the Close button. 
 

 The new shapefile will be added to the table of contents: 
 

Output location: either use the 
browse button to select the folder 
C:\TRAINING\DATA\MERGE or type 
in the directory location yourself 

Output feature class: type in 
the name ONEBLOCK  

Template feature class, select 
from drop-down list: Sector1 it 
will be added to the list below. 
The Template feature class 
defines fields (attributes) that 
will be copied to the new 
output feature class.  

Leave all other values as 
default settings 

If you need help for any item in 
the dialog box, click the Show 
Help >> button 

The Geometry will be Polygon 
(the default setting) 
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Note: If there are any errors running the tool they will appear in red. The most common 
mistake is caused by mistyping a directory or folder name. 

Step 2: Append shapefiles together 
 

 In ArcToolBox and navigate to the ArcTool > Data Management Tools > General toolset 
and double click on the Append tool: 

 

 
 

The Append tool allows you to merge separate tiles or layers of data together into a single 
seamless dataset, having created an empty feature class called oneblock.shp you will now 
merge sector1.shp and sector2.shp into it: 

 Complete the Append dialog box as follows: 
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 Click OK to continue. Dismiss the progress dialog box by clicking the Close button. 

The result is a single seamless block: 

 

 When you have finished save the map document in your C:\TEMP directory as 
ExMerge.mxd.  

Input features: Sector1 and 
Sector2, select these from the 
drop-down list, they will be 
added to the list below. You 
must ensure all input features 
share the same fields 
(attributes) otherwise record 
values will be lost 

Output features: ONEBLOCK, 
select this from the drop-down 
list 

Leave all other values as 
default settings 

If you need help for any item in 
the dialog box, click the Show 
Help >> button 
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EXERCISE 11: ESTABLISHING HYPERLINKS 
 
In this exercise you will set up hyperlinks to link mutation forms in one of two ways – 
dynamically using the Identify tool and permanently by entering values in an attribute table. If 
you set up dynamic hyperlinks you must share the map document with other users, if you 
enter values into the attribute table you need only share the source data or layer file. 
 

 Start ArcMap and choose to open a new map document. 
 

 Click on the Add Data tool in the application GUI  and navigating to the 
C:\TRAINING\DATA\HYPERLINKS directory add the shape files: Streets.shp  and 
Buildings.shp. 

 
Step 1: Setting dynamic hyperlinks 
 

 Click on the Find tool in the Tools toolbar  
 

 In the Find dialogue box, for ‘Find’ type in ‘El Montazah No. 1 St’, set ‘In:’ to ‘Streets’: 
 

 
 

 Click the Find button to search for matching record values. 
 

Only one record will be returned. 

 

Use the drop-down list to 
select the Streets layer 
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 Select the record and right clicking on the mouse choose Zoom to Feature(s): 
 

 
 

The display will centre on ‘El Montazah No. 1 St’  street. In the middle of the display is a 
large rectangular building. You will you associate a mutation form with this building. 

 

 

 
 

 Close the Find dialog box. 
 

 In the Tools toolbar select the Identify tool  and click on the parcel shown above. 
 

Set up a hyperlink for this 
building 
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 In the Identify Results dialogue box right click on building identifier (48364) and choose 
Add Hyperlink… from the context menu: 

 

 
 

 Accept the setting ‘Link to a Document’ and click the Browse button : 
 

 
 

 Navigate to the folder C:\TRAINING\DATA\HYPERLINKS. Select the JPEG file 
‘Mutation48364.jpg’ and click Open: 

 

 
 

Note: In this exercise you will set 
up hyperlinks to JPEG files, 
however, mutation forms will be 
scanned as TIFF files. This 
exercise is illustrative only. 
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 Click OK to dismiss the Add Hyperlink dialog box and close the Identify Results window. 

 In the Tools toolbar select the Hyperlink tool  and click on the building now identified 
with a blue outline: 

 

 
 

 The mutation form will open. Once you have examined it, close the image viewing 
application it opened in (e.g. Windows Fax and Image View). 

 

This is a dynamic way of storing hyperlinks. Note however this is only valid for the map 
document you are working with. To permanently associate a hyperlink you would add 
records to the attribute table, you will see how to do this in the next step. 

 

Step 2: Setting permanent hyperlinks 
 

 In the Tools toolbar click on the Full Extent tool   
 

 In the table of contents, right click on the Buildings layer and choose Open Attribute 
Table in the context menu: 
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 In the table window click the Options  button and choose Add Field…: 
 

 
 

 In the Add Field dialog box, name the new field ‘Mutation’; set it’s type ‘Text’ and length 
to ‘100’: 

 

 
 

 Click OK to continue. 
 

Next you will build two queries to select the buildings with identifiers 46994 and 48403 and 
then update the record values for the Mutation field. Below are the mutation forms for the 
each building. You will notice that they share the same directory base (up to \HYPERLINK). 
It means you don’t actually have to add everything to the Mutation field just that which 
appears after \HYPERLINK\ as you can set a hyperlink base as a property of the map 
document: 

 

Building 46994: C:\TRAINING\DATA\HYPERLINKS\MUTATION46994.JPG 

Building 48403: C:\TRAINING\DATA\HYPERLINKS\MUTATION48403.JPG 

 

 

The maximum number of 
characters for a field in a 
shapefile is 10. If the name is 
longer than this it will be 
truncated (i.e. shortened) 
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Using Building 46994 as the example: 

 

 In the table click on the Options  button and choose Select By Attributes… 
 

 Build the expression "OBJECTID" = 46994 and click the Apply button: 
 

 
 

 Close the Select by Attributes dialogue box. 
 

 In the table window click the Selected button to display the single selected record. 
 

 Scroll to the right until you can see the ‘Mutation’ field. 
 

 From the Editor toolbar choose Start Editing. 
 

 Click in the record for ‘Mutation’ field and enter: Mutation46994.jpg 
 

 Now repeat the step for building 48403.  
 

 When finished choose Stop Editing from the Editor toolbar. Choose to save the edits you 
have made, and then close the attribute table. 

 

 From the File menu choose Map Properties… and in the Hyperlink base field enter: 
C:\TRAINING\DATA\HYPERLINKS and click OK. This base value will be applied to all 
field values: 

 

 
 

 Next select the Buildings layer in the table of contents and clicking on the right hand 
button of the mouse choose Properties… from the context menu. 
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 In the Layer Properties dialog box click on the Display tab. 
 

 Check on the option the ‘Support Hyperlinks using field’ and select the ‘Mutation’ field 
from the drop-down list: 

 

 
 

 In the Tools toolbar click on the Hyperlink tool. The two buildings will be identified with 
blue outlines, click on either one of them to see the associated mutation form. 

 

 When you have finished save the map document in your C:\TEMP directory as 
ExHyperlinks.mxd.  
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EXERCISE 12: ASSOCIATING MUTATION FORMS 
 
In this exercise you will learn how to use the ArcMap Join and Relate commands to 
associate mutation form details held in a MS Access database using the ‘Mutation Form 
Number’ as the common field. 

 Start ArcMap open the map document Indexing.mxd the C:\TRAINING\DATA\MAP 
DOCUMENTS folder. The map document contains a parcels layer symbolized according 
to whether a mutation form number has been assigned or not. 

Step 1: Add the tables to the map document 
 

 In the Standard toolbar click the Add Data tool  
 

 Navigate to the C:\TRAINING\DATA\INDEXING folder and double click the Mutation 
Forms.mdb database to open it. 

 
 Add the two personal geodatabase tables: ‘Property Object’ and ‘Subsequent 

Transactions’: 
 

 
 
Since the tables contain information regarding the property you will now use the Join and 
Relate commands to build an association. 
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Step 2: Join the Property Object table to the Parcels layer 
 

 Right click on the Parcels layer and choose Joins and Relates > Join… and complete the 
Join Data dialog box as follows: 

 

 
 

 Click the Advanced… button and check the option ‘Keep only matching records’: 
 

 
 

 Click OK to continue and OK to dismiss the Join Data dialog box. Only a single parcel 
will remain in the display. 

 
 Right click on the Parcels layer and scroll through the table to see the additional fields 

that have been added. You will notice that the field name is preceded by the table which 
it has come from. 
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 Close the Parcel layer’s attribute table. 
 

 In Tools toolbar click on the Identify tool and click in the centre of the single parcel in the 
display examining the attributes that describe it – namely information relating to the first 
transaction for which the mutation form was created: 

 

 
 
Here you have used the Join command to append fields from the Property Object table to 
the Parcels layer; you have been able to do this because this is a one to one relationship 
type. However, since there are many subsequent transactions in order to associate the 
Subsequent Transactions table with the parcel layer you will have to use the Relate 
command. 
 
Step 3: Relate the Subsequent Transactions table to the Parcels Layer 
 

 Right click on the Parcels layer and choose Joins and Relates > Relate… from the 
context menu. 

 
 Complete the Relate dialog box as follows: 
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 Click OK to continue 
 

 Use the Identify tool to click on the parcel 
 

 In the left hand pane of the Identify Results dialogue box, click the plus (+) button to the 
left of the parcel number, then the click the plus (+) sign next to the table ‘Subsequent 
Transactions’.  

 
You will see the two records you added to the Subsequent Transactions table identified 
numerically: 
 

 
 

 Click on each one to see the details of these transactions in the Identify Results window. 
 

 Close the Identify Results window.  
 

 Since you have finished save the map document in your C:\TEMP directory as 
ExJoin.mxd.  
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EXERCISE 13: MAP PRODUCTION 
 
In this exercise you will learn how to prepare a cadastral index map in ArcMap. 
 

 Start ArcMap and choose to open an existing map document. 
 
Step 1: Open a map document 
 

 Navigate to the C:\TRAINING\DATA\MAP DOCUMENTS directory and open the map 
document Map Production.mxd. 

 
The map document contains three layers: Buildings, Parcels and Streets: 
 

 
 
You will notice the symbology of the layers is not correct (i.e. it does not follow ESA 
guidelines as symbols are assigned randomly). Using tools in ArcMap you will first assign 
the correct symbols to all three layers and label the streets. 
 
Step 2: Set symbology and labeling for layers 
 

 Right click on the Streets layer and choose Properties… from the context menu. 
 

 In the Layer properties dialog box click on the Symbology tab: 
 

 
 

 Click on the current symbol for the streets layer (a thin green line). 
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 In the Symbol Selector dialog box click on the Color drop-down arrow and set the color 
of the line to black. Leave the width as 1: 

 

 
 

 Click OK to dismiss the Symbol Selector dialog box. 
 

 Click the Apply button in the Layer properties dialog box to apply the changes to the 
layer, but keep the dialog box open. 

 
 Next click on the Labels tab in the Layer properties dialog box: 

 

 
 

 Confirm the Label Field is ‘st_name’ – this is the first text field in the attribute table. 
 

 Click on the Symbol… button. 
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 In the Symbol Selector dialog box set the Font to ‘Times New Roman’ and the Size to 
10: 

 

 
 

 Click OK to dismiss the Symbol Selector dialog box. 
 

 Check the option ‘Label features in this layer’, then click the OK button in the Layer 
Properties dialog box: 

 

 
 
The streets will be labeled by name: 
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CHALLENGE STEP 
 
Next repeat the steps described for the streets layer to symbolize the parcels and buildings 
layers with black outline (Width 1 ) and no fill (i.e. hollow). There is no need to label either 
the buildings or parcels as there are no major buildings in this block. Can you do this? If not 
please ask your instructor for guidance. 
 
Step 3: Create a layout 
 
In this step you will create a simple cadastral index map that looks something like this: 
 

 
 
Do not worry if yours is not exactly the same. Follow the steps on the next page to get 
started. 
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 Right click on the Layers data frame and choose Reference Scale > Set Reference 
Scale, by setting a reference scale when you zoom in symbols and text will get larger: 

 

 
 

 From the View menu choose Layout View, switching to the layout view means you can 
begin the process of map design. 

 
 In the Standard toolbar set the scale to 1:1000. Using the scale notation in the Standard 

toolbar allows you to create fixed scale maps: 
 

 
 
You will notice both labels and outlines appear bigger in the layout, this is because you set a 
reference scale: 
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Now add a scale bar: 
 

 From the Insert menu choose Scale Bar… 
 

 In the Scale Bar Selector dialog box, select the ‘Alternating Scale Bar 1’ scale bar and 
click the Properties… button. 

 
 Under the Scale and Units tab set the following options: (i) Division Value 25 m (ii) When 

resizing… ‘Adjust number of divisions’: 
 

 
 

 Click OK to dismiss the Scale Bar dialog box. 
 

 Click OK to dismiss the Scale Bar Selector dialog box and place the Scale Bar on the 
Layout. 

 
 Use the Select Elements tool in the Drawing toolbar to drag the scale bar to an 

appropriate location: 
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Next add a north arrow: 
 

 From the Insert menu choose North Arrow… 
 

 In the North Arrow Selector dialog box select the ‘ESRI North 3’ north arrow and click OK 
to dismiss the North Arrow Selector dialog box and place the north arrow on the layout. 
Again use the Select Elements tool to place the North Arrow in an appropriate location. 

 
Next add a title: 
 

 From the Insert menu choose Title 
 
The Title is actually the name of the map document so change this: 
  

 Overtype the text ‘Map Production’ with ‘CADASTRAL INDEX MAP’ and press the Enter 
key on the keyboard. 

 
Lastly add a legend: 
 

 From the Insert menu choose Legend… 
 

 In the first dialog box accept the default settings – all the layer’s legends will appear in 
the layout. Click Next>> to continue: 

 

 
 

 For Legend title accept the default settings and click Next>> to continue. 
 

 For Legend frame accept the default settings and click Next>> to continue. 
 

 For Legend symbols accept the default settings and click Next>> to continue. 
 

 For Legend spacing accept the default settings and click Finish to place the legend on 
the layout. Again use the Select Elements tool to place the Legend in an appropriate 
location. 

 
And that’s it, obviously more can be added, but these are the principles of map design. Since 
you have finished save your work: 

 Save the map document in your C:\TEMP directory as ExMapProduction.mxd.  
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ANNEX C:  
 

Course evaluation form 



ESA CADASTRAL OPERATIONS COURSE 
 

 
 
Instructor: 
 
Class Location: 
 
Date: 
 
Your Name: 
 
Organisation: 
 
Job Duties: 
 
 
About You 
 
What percentage time do you 10-20%  21-40% 41-70% 71-100%   
spend performing 
Surveying tasks? 
 
What percentage time do you 10-20%  21-40% 41-70% 71-100%   
spend performing 
GIS tasks? 
 
What percentage time do you 10-20%  21-40% 41-70% 71-100%   
spend performing 
GPS tasks? 
 
 
 
What did you learn? 
 
 
 
 
 
How to….         Comments: 
            
Describe the methodology?         
 
Scan and index mutation forms? 
 
Transform raster and vector data? 
 
Establish control points using GPS? 
 
Survey a parcel boundary using Total Station? 
 
Save survey data to ESRI shapefile format? 
 
Perform quality control tasks? 
 
Create a cadastral index map? 
 
 
What additional course content should we include? 
 
 
 
 
 
 
 
 
 
 
 
 

Continued on back

N
ot Learned

Learned

C
an’t say



How were the course materials? 
 
 
 
 
          Comments: 
     
Easy to work with? 
 
Well organised? 
 
Thorough? 
 
Clear directions in the exercises 
 
Will you use the materials after the class? 
 
How might we improve the materials? 
 
 
 
 
 
 
How was the instructor? 
 
 
 
          Comments: 
 
Knowledgeable 
 
Presented material clearly and 
effectively  
 
Encouraged class participation 
 
Answered questions clearly and 
completely 
 
Paced the class too slow 
 
Paced the class too fast 
 
How might the Instructor improve the 
presentation? 
 
 
 
 
What did you like best about this course? 
 
 
 
 
 
 
 
Suggestions for otherwise improving this course: 
 
 

D
isagree 

 Agree 

D
isagree

Agree
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ANNEX D:  
 

Glossary of terms 
 
 



GLOSSARY 
 
Adjudication A judicial decision or formal judgment by a court or tribunal. Systematic 
adjudication is generally carried out during the introduction of a system of title 
registration to investigate and identify and adjudicate all rights, responsibilities and 
interests connected with individual real property objects. These are then registered 
against the object in the title register. 
 
Aerial Survey A survey of an area made by taking sequential photographs from an 
aircraft; plans are then drawn from the aerial photographs. 
 
Benchmark A permanent reference mark or point established for use by surveyors in 
measuring differences in elevation. 
 
Boundary The line which separates property in one ownership from its neighbour(s); 
it is therefore the limit in all directions to which the ownership extends. 
 
Building Footprint Building footprint data should be collected from sources, as 
paper or digital data, however it may be necessary to undertake field measurements 
to determine their actual spatial location. 
  
Cadastral Form (Sahiyfa akariya) Used in the Sigueal el-ainee system as the form 
on which ownership information is recorded. Every parcel has its Cadastral Form. 
The Cadastral Form is akin to what is called a registration card or registration sheet 
in other countries. It is the document referred to in Article 58 of Law 142 of 1964 (the 
Sigueal el-ainee Law). That Law also refers to the Cadastral Form as a title deed 
(sanad al mulkkaya).  The original of the Cadastral Form is kept in the central 
registration office. A copy of the Cadastral Form is provided only to the original parcel 
owner. Subsequent owners receive Certificates (Shaheda) pursuant to Article 59 of 
Law 142 of 1964. 
 
Cadastral Information Form (CIF) (kashf tahadeed) The form generated by the 
ESA district office (EDO) describing the property that is the subject of a transaction.  
The EDO must provide the CIF to the local registration office (RO) before the RO will 
proceed with registering a transaction. 
 
Cadastral Index Map The purposes of a cadastral index map is not to show each 
individual property with high spatial accuracy but rather to show properties in their 
correct spatial relationships to each other.  Historically, cadastral index maps were 
often built up from surveys of individual parcels, a bottom-up approach. The bottom-
up approach requires generalization of the individual parcel maps to get an overview 
map in which all parcels fit smoothly.  In modern times, with the availability of 
computerized maps, aerial and satellite photography, and other top-down views, 
cadastral index maps are often prepared independently in parallel with the surveys of 
individual parcels. 
 
Cadastral Plan (Location Plan) A plan which, for clarity of interpretation, is of a 
large scale (e.g. 1:1,250 or 1:2,500) to show the position of a specific property in 
relation to its surroundings. 
 
Cadastral Survey A survey carried out for the determination, identification, 
reestablishment of adjustment of the boundaries of a property on a plan. 
 



Cardinality The correspondence or equivalency between sets; how sets relate to 
each other. For example, if one row in a table is related to three rows in another 
table, the cardinality is one to many. 

CCITT Group 4  This is a form of data compression commonly applied to images. 
roup 4 compression is a two dimensional algorithm that produces better compression 
results than Group 3, and is used by Ariel systems. CCITT stands for Comite 
Consultatif Internationale de Telegraphie et Telephonie. In the early 1990's the 
CCITT organization changed its name to ITU-T (International Telecommunications 
Union-Telecommunication), but the old French name lives on 

Certificate of Authenticity (Shaheda) The certificate issued pursuant to Article 61 
of the Sigueal elainee Law to confirm the authenticity of a copy of the Cadastral Form 
or Certificate issued under Article 59.  Certificate of Title A statement of opinion on 
the status of the title to a parcel of real property based on an examination of specified 
public records. 
 
Deed A document, being written evidence of a legal transaction, which has been 
signed, sealed and delivered to testify to the agreement of the parties concerned. 
 
Displacement Link A displacement link is a displacement vector that represents a 
source location to a destination location. 
 
DXF Data Exchange File, a two-dimensional graphics file format supported by 
virtually all CAD and GIS products. It was created by AutoDesk for the AutoCAD 
system. 
 
Easement A right to use the land of another for a specific purpose, such as for a 
right-of-way or utilities; an incorporeal interest in land. 
 
Encroachment Unauthorized extension of the boundaries of a piece of land over 
adjoining land, via occupation, which belongs to another. 
 
Feature class A collection of features that share the same geometry and attributes. 
 
Geodatabase A geodatabase is the storage of geographic data implemented with a 
relational database. All geodatabase elements are managed in standard RDBMS 
tables using standard SQL data types. A personal geodatabase is a MS Access 
database with feature classes stored as tables in the mdb file. Personal 
geodatabases can only be edited by one person at a time. 
 
Ground Control Points (GCPS) A system of points with known positions used as 
fixed references in geo-referencing map, plans, aerial photographs, or remotely 
sensed images. 
 
Identity Link An Identity Link is a link whose source and destination coordinate are 
the same. 
 
Mutation Form The document generated by the EDO when a parcel is created.  It 
contains spatial information regarding the real property object as well as ownership 
information that is updated each time there is a transaction. The spatial information is 
generated through results of cadastral surveys performed by EDO or EPO surveyors. 
 



Final Output The Cadastral map should include in addition to the previous a basic 
component of the map should be included such as map legend, north arrow and key 
or link to adjoining maps.  
 
Map Scale Simply defined, scale is the relationship between distance on the map 
and distance on the ground.  A map scale usually is given as a fraction or a ratio 
1/1000 or 1:1000. These "representative fraction" scales mean that 1 unit of 
measurement on the map, 1 centimetre represents 1000 of the same units on the 
ground. "The larger the number, the smaller the scale".  ESA has already produced 
many maps at different scales.  The most important factor in choosing the scale in 
urban areas is to show a lot of details.  The most commonly used scale for cadastral 
mapping purposes is 1:1000.  This scale is large enough to allow most features such 
as parcel boundaries and building footprints to be drawn to scale. 

 
Parcel Identifiers Each parcel should have assigned to it a unique identification 
number that links the specific parcel with files containing ownership data.  Parcel 
identifiers provide a common index for all property records and may help track 
changes in legal descriptions in a uniform and more manageable way. 
 
Parcel Polygon Polygon layer that can be of great value to the Registration, this 
polygon indicate the parcel boundary. 
 
Plan 1) A drawing to scale of the layout and construction of a part of a building, 
whether existing or proposed, in horizontal section e.g. of a particular floor or set of 
rooms, and showing details such as windows, doors and permanent partitions. 2) A 
drawing of a relatively small area of land, usually drawn to a large scale and including 
details of boundaries, buildings, structures, service and other man-made features of 
a relatively permanent nature in addition to physical features. 3) A set of proposals 
for the performance of a task or undertaking in a controlled manner or in a series of 
predefined steps according to certain principles or rules. In the case of the future 
development of an area, it would probably embrace maps and written statements.  
 
RDBMS Relational Database Management System. A type of database in which data 
is organized across one or more tables. Tables are associated with each other 
through common fields called keys, examples include MS Access, SQL Server and 
ORACLE. 
 
Registered Contract (ad el baiya el nehaie) A final contract, sometimes referred to 
as a deed, registered under the Sigueal el-shaksi system. The original is printed on 
oversized green paper and is kept in the central registration office. A blue copy on 
laminated legal size paper is provided to the owner.   
 
Root Mean Square Error (RMS) A root mean square error (RMS) describes the 
deviation that will occur when the transformation is applied to the input and the output 
coordinate systems. The error is determined using the least squares regression 
method.  
 
Rubbersheeting A procedure for adjusting the coordinates of all the data points in a 
dataset to allow a more accurate match between known locations and a few data 
points within the dataset. Rubber sheeting preserves the interconnectivity between 
points and objects through stretching, shrinking, or reorienting their interconnecting 
lines. 
 



Shapefile An ArcView GIS data set used to represent a set of geographic features 
such as streets, buildings or parcels. Shapefiles can represent point, line, or area 
features. Each feature in a shapefile represents a single geographic feature and its 
attributes. 
 
Sigueal el-ainee Registry of real property (all rights, responsibilities and interests are 
registered against real property objects). 
 
Sigueal el-shaksi Personal registry (meaning registration of real property objects 
against the name of a person). 
  
Site Plan A drawing of an area of land, on a horizontal plane, showing the 
boundaries and physical extent of the land included in a particular parcel. It may also 
show existing buildings or the proposed layout of a development. 
 
Subdivision A tract of land divided by the owner, known as the sub divider, into 
blocks, building lots, and streets according to regulations. 
 
Survey A process of investigation into some subject involving measurement and/or 
assessment, e.g. building survey; land survey; land use survey; pedestrian survey. 
 
TIFF Tag Image File Format. t is one of the most popular and flexible of the current 
public domain raster file formats. 
 
Traversing A method of land surveying by measuring angles with a theodolite or 
total station, from each station to other stations, measuring the distance between 
stations and plotting the results. The stations are generally used as local geodetic 
control points for land surveys. 
 


